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1. Obtenção de Dados 

1.1 Modelo Digital de Elevação SRTM30 

Pode-se obter os arquivos do Modelo Digital de Elevação (MDE, ou também no 

inglês DEM, digital elevation model) da área em questão nesse sítio. Esse MDE é 

derivado da Shuttle Radar Topography Mission, SRTM, o qual tem resolução horizontal 

média de 30 metros. 

Pode-se unir estes arquivos via ferramenta “Mosaico” do ArcGIS. Mais detalhes 

neste sítio. 

Deve-se sempre manter em mente que anualmente novos MDE são gerados, e  que 

para a área em que se está trabalhando, pode haver um MDE de melhor resolução. Em 

sítio, por exemplo, podem-se visualizar alguns MDE de melhor resolução para o Rio de 

Janeiro e Santa Catarina. Deve-se se manter atento a essas atualizações. 

1.2 Inventário da Agência Nacional de Águas 

a) Nesse sítio, clica-se em “Softwares”. 

 

  

http://earthexplorer.usgs.gov/
https://onedrive.live.com/view.aspx?cid=f3e4c2a1ea29981a&page=view&resid=F3E4C2A1EA29981A!222&parId=F3E4C2A1EA29981A!220&app=WordPdf
ftp://geoftp.ibge.gov.br/modelos_digitais_de_superficie/modelo_digital_de_elevacao_mde/
http://hidroweb.ana.gov.br/default.asp
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b) Na nova janela aberta, no item “3. Inventário pluviométrico/fluviométrico 

atualizado”, baixa-se o arquivo “Inventário.zip”, e anota-se a data da atualização. 

Aqui, no caso, 13/04/2017. 

 

Aconselha-se também baixar o software “Hidro” no item “1. Hidro” para auxiliar 

a visualização e o acesso aos dados hidrológicos do inventário. Em algumas etapas deste 

presente tutorial, utiliza-se como base o layout do Hidro. 

 

c) O inventário encontra-se inicialmente compactado. Utiliza-se um programa 

descompactador, como o Winzip ou Winrar, para extrair o inventário para uma pasta. 

Ao extrair, notar-se-á que o formato é .mdb, o qual pode ser lido pelo programa 

Access. Recomenda-se renomear o arquivo .mdb com a data de atualização do 

inventário, já que este é uma informação chave e deve ser informada no diagrama. 

Como importar os dados do arquivo .mdb para o programa de SIG está descrito no 

item de 2. Preparação de arquivos. 

1.3 Inventário do SIGEL 

Acessando este sítio, clica-se em “Download” para acessar o mapa de download de 

dados.  

http://sigel.aneel.gov.br/portal/home/
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Após isso, clicar em shapefile (1), estender a janela aberta de shapefile para 

facilitar a visualização, selecionar as camadas desejadas para o download (2), descer a 

barra de rolamento e clicar em “Executar”. Costumeiramente, estaremos interessados nas 

seguintes camadas: CGH, UHE e PCH. Há a Camada AHE que representa todas juntas 

(Aproveitamentos Hidrelétricos). 

 

2 

1 
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Assim, será gerado um link para download na aba de saída com os arquivos 

desejados em formato zip. 

 

Extrai-se os arquivos, utilizando um descompactador (Winzip ou Winrar). 

Aconselha-se aqui sejam salvos juntos na mesma pasta. Pode-se adicionar os arquivos ao 

ArcGIS/QGIS, estando esses em formato .shp. Basta arrastá-los. 

1.4 Hidrografia ANA, IBGE, e versões regionais (HW, 2010) 

Para auxiliar no desenvolvimento do Diagrama Unifilar, é interessante obter os 

traçados de drenagem da ANA. Estes arquivos podem ser baixados do GeoNetwork. 

Nesse repositório há diversos arquivos. Um deles, de abrangência nacional, é a Base 

Hidrográfica Ottocodificada Multiescalas 2013. 

Há também a hidrografia compilada do IBGE. Dentro da assim intitulada Base 

Cartográfica Contínua do Brasil 1:250000 de 2015 (BC250, 2015), há dados de 

hidrografia para a nação inteira. O sítio direto para a hidrografia para a BC250 de 2015 

é este. Eventualmente o nome das pastas pode ser alterado pelo departamento de TI do 

IBGE. Caso isso aconteça, o endereço não funcionará e será necessário procurar na rede 

FTP do IBGE. 

Quando existente se faz também de bases hidrográficas regionais. No caso do Rio 

Grande do Sul, há a base hidrográfica de Hasenack e Weber (2010) <https://www.ufrgs.

br/labgeo/index.php/dados-espaciais/250-base-cartografica-vetorial-continua-do-rio-

grande-do-sul-escala-1-50-000>. A hidrografia de Hasenack e Weber (2010) está 

http://metadados.ana.gov.br/geonetwork/srv/pt/main.home
ftp://geoftp.ibge.gov.br/cartas_e_mapas/bases_cartograficas_continuas/bc250/versao2015/Shapefile/Hidrografia_v2015.zip
ftp://geoftp.ibge.gov.br/
ftp://geoftp.ibge.gov.br/
https://www.ufrgs.br/labgeo/index.php/dados-espaciais/250-base-cartografica-vetorial-continua-do-rio-grande-do-sul-escala-1-50-000
https://www.ufrgs.br/labgeo/index.php/dados-espaciais/250-base-cartografica-vetorial-continua-do-rio-grande-do-sul-escala-1-50-000
https://www.ufrgs.br/labgeo/index.php/dados-espaciais/250-base-cartografica-vetorial-continua-do-rio-grande-do-sul-escala-1-50-000
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disponível em diferentes projeções. Para o Rio Grande do Sul, estando esse em zona de 

latitudes intermediárias, recomenda-se utilizar a projeção conforme de Lambert de dois 

paralelos. Informações mais aprofundadas dessa projeção podem ser obtidas neste ou 

neste sítio.  

1.5 Municípios IBGE  

Dados georeferenciados de municípios podem ser obtidos em “bases e referencias 

» bases cartográficas » malhas digitas”. O último levantamento em formato shapefile 

disponível é de 2015 e pode ser obtido neste sítio. Acessando “Municipal 2015”, pode-se 

procurar “br_município.zip”. 

Caso o usuário necessite do endereço para download direto. Esse endereço pode, 

porém, já estar corrompido porque de tempo em tempo a estrutura de pastas do FTP do 

IBGE é alterada. 

2. Preparação dos arquivos 

Escolhe-se entre duas opções neste tutorial para realizar os procedimentos de 

preparação de arquivos: usar o ArcGIS ou o QGIS. Fica a critério do usuário qual dos 

programas utilizar, sendo que ambos apresentam resultados semelhantes. 

2.1. Utilizando o ArcGIS 

2.1.1. Caminhos relativos no ArcGIS 

Antes de começar a trabalhar com o ArcGIS, recomenda-se habilitar a opção de 

armazenamento de nomes de caminhos relativos para fontes de dados.  

Por padrão o ArcGIS utiliza o caminho (ou endereço) completo para busca de 

qualquer arquivo adicionado no mapa, porém pode-se alterar essa opção, tornando 

relativo o caminho do arquivo mapa .mxd até os arquivos que estão presentes no mapa 

(e.g. dado um aquivo .shp localizado em C:\ArcGIS\projeto\subbacia81.shp e um arquivo 

do mapa do ArcGIS C:\ArcGIS\projeto\projeto_mapa_sb81.mxd, o caminho relativo 

passaria só pela própria pasta). Qual a vantagem? Caso se copie a pasta projeto para um 

pendrive, pode-se abrir o arquivo .mxd e ele vai reconhecer que o caminho relativo até o 

https://docs.lib.noaa.gov/rescue/cgs_specpubs/QB275U35no47.pdf
https://pubs.usgs.gov/pp/1395/report.pdf
http://mapas.ibge.gov.br/bases-e-referenciais/bases-cartograficas/malhas-digitais.html
ftp://geoftp.ibge.gov.br/organizacao_do_territorio/malhas_territoriais/malhas_municipais/municipio_2015/Brasil/BR/br_municipios.zip
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arquivo .shp  é pela mesma pasta em que o .mxd está; prontamente o arquivo .shp será 

encontrado.  

Note ainda que a pasta “projeto” poderia ser realocada em qualquer local já que os 

arquivos todos estão dentro de “projeto” e o caminho relativo entre .mxd e os arquivos 

não mudou. Diferentemente, quando não marcada a opção de caminhos relativos, se o 

nome do disco local for alterado de “C:” para “G:”, aparecerá o seguinte ícone ao abrir o 

arquivo .mxd: 

 

Caso isso aconteça será necessário localizar de novo o caminho da camada, e isso 

será um trabalho dispendioso e cansativo. Para evitar tais problemas, deve-se clicar na 

aba “Arquivo”, em “Propriedades do Documento do Mapa...” e habilitar a caixa 

“Armazenar nomes do caminho relativo para fontes de dados” como mostra as figuras 

abaixo. 

 

Para não precisar marcar essa opção toda vez que começar um novo trabalho, clica-

se na aba “Personalizar”, em “Opções do ArcGIS...” e marcar a caixa “Tornar os 

caminhos relativos o padrão para novos documentos” na aba “Geral”, como mostra as 

figuras abaixo. 
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2.1.2. Importar Inventário ANA de formato .mdb para ArcGIS 

a. Abre-se o arquivo Access e, dentro dele, a tabela “Estacao”. 

 

b. Na Barra de Ferramentas, clica-se “Dados Externos”. No espaço “Exportar”, 

clica-se em “Excel” para exportar para planilha do Excel em formato .xlsx. 
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c. Define-se nome, local e formato do arquivo de destino. Utiliza-se formato 

“.xlsx”. Novamente, recomenda-se manter a data de atualização no título do arquivo. 

Sugere-se, por exemplo, “2017-04-14-Inventário” uma vez que o formato “ano-mês-dia” 

facilita analise de um banco de dados grande. Isso é particularmente importante quando 

se pretende atualizar o diagrama rotineiramente. 

 

d. (Opcional) Preenche-se células em branco, e interpreta-se códigos ANA de 

interesse. 

Motivação 

Para que serve o Hidro na hora de visualizar os dados? 

O Hidro interpreta os valores de cada coluna do arquivo .mdb 

Pode-se montar uma simbologia, e utilizar rótulos (labels) no 

programa de SIG, utilizando assim apenas um programa. Basta 

que se entenda o significado de cada coluna da planilha de 

Estacao do .mdb de Inventário. 

Abre-se o arquivo Excel recém-exportado do Access, e realiza-se algumas mudanças que 

facilitarão a visualização das informações de altitude, área de drenagem, e municípios. O ArcMap 

interpreta células em branco como zero, o que pode eventualmente levar a equívocos (e.g. uma 

estação pode exibir altitude zero, porém, na verdade, nunca se mediu a altitude dessa estação). 

Também, encontra-se o campo de município sob um código apenas utilizado pela ANA, e esse 

não é interpretável sem a presença da relação “código da ANA - nome do município”. 

Para renomear todas as células em branco de altitude e área de drenagem para “-

9999”, sugere-se no Excel seguir seguinte processo: seleciona-se primeiramente a coluna 

com brancos a serem preenchidos, depois, na barra de ferramentas, clica-se em 

“Classificar e Filtrar”, “Classificar do Menor para o Maior” (o Excel pode estar lendo 

essa coluna como string e aparecerá “Classificar de A para Z”. Nesse caso, seleciona-se 

essa opção). 

 

D:\2017-04-14-Inventário.xlsx 
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Uma janela de aviso abrirá. É extremamente importante que se marque “Expandir a 

seleção” antes que se clique em “Classificar”.  

 

Clica-se numa das células não nulas dessa coluna que agora foi classificada em ordem 

crescente, segurar “Ctrl”, clicar “↓”, soltar “Ctrl”, clicar “↓” (1), digitar -9999 (2), e dar duplo 

clique no pequeno quadrado preto no canto inferior direito dessa mesma célula (3). Isso copiará 

todos os valores -9999 até a última célula em que não há dados (4). Realiza-se esse processo tanto 

para coluna de altitudes assim como para a de área de drenagem. 

 

Ainda se faz necessário adicionar uma nova coluna para o nome de município. Insere-se 

uma nova coluna e a ela dá-se o nome “MunicípioNome”. 

 

Insere-se uma planilha nova (ou, pressiona-se Shift+F11) na qual se coloca a relação 

“código da ANA - nome do município”. A ela, dá-se o nome de “Municípios”. 

 (1)       →           (2)  →       (3)            → (4) 
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Faz-se necessário seguir procedimento semelhante ao já realizado, em que se exportou a 

tabela de “Estacoes” do arquivo .mdb, no qual se encontra o inventário da ANA. Agora, porém, 

deve-se exportar, também em formato .xlsx, a tabela “Municipio”, ao invés de “Estacoes”. 

Sugere-se utilizar o nome “Municipio.xlsx”.  

Uma vez exportada a tabela Municipio, deve-se abrir ela. Agora há dois arquivos Excel 

abertos. Copia-se as colunas Codigo e Nome do arquivo “Municipio.xlsx” para a nova planilha 

inserida no arquivo Excel do inventário de estações. Segue imagens abaixo: 
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Voltando-se a planilha “Estacao”, na primeira célula da coluna “MunicipioNome” 

anteriormente criada, escreve-se a seguinte função: 

 

“=ÍNDICE(Municipios!$A$2:$B$5706;CORRESP(J2;Municípios!$A$2:$A$5706;0);2)” 

 

E dá-se duplo clique no pequeno quadrado inferior direito da célula. Assim, acaba-se por 

copiar essa função para todas as células abaixo nessa mesma coluna. Espera-se que apareça o 

nome de todos os municípios. 

 

Pode haver eventualmente algum erro na função acima mencionada caso os dados não 

tenham sido copiados e colados exatamente como apontado, e.g. o nome da planilha inserida 

(Shift+F11) não seja o sugerido (“Municípios”). Além disso, com o passar dos anos, a lista de 

municípios da ANA pode apresentar mais ou menos municípios, e isso implicaria em uma matriz 

relação código-município de tamanho diferente. Enfim, ocorrendo algum erro, ou sendo de 

interesse do usuário a lógica da função acima mencionada, segue explicação abaixo: 

“=ÍNDICE(Municipios!$A$2:$B$5706;CORRESP(J2;Municipios!$A$2:$A$5706;0);2)” 

“=ÍNDICE(matriz relação código-nome;CORRESP(código de município da estacao que 

será procurado na matriz relação código-nome;coluna de códigos da matriz relação código-

nome;o valor 0 indica que se deve buscar uma correspondência exatamente igual entre o código 

de município da estação e o código presente na coluna de códigos da matriz relação código-

nome*);o número 2 indica que, após ter sido encontrado o valor na matriz relação código-nome, 

deve-se retornar o dado na segunda coluna dessa matriz)” 

               *Às vezes se utiliza essa função para buscar valores que são menores, ou maiores do que os que contam na 

coluna. Esses artifícios não são usados para resolução desse problema, no entanto. 
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Pode-se realizar processo semelhante para adicionar uma coluna com o nome de rios, já 

que a priori só há coluna de código de rios. Nesse caso, os parâmetros da função ÍNDICE serão 

diferentes, e deve-se adicionar uma planilha relação “código-nome” que se extrai também do 

.mdb. No arquivo .mdb, o nome da planilha a ser exportada é “Rio”. 

Por fim, finalmente, salva-se o excel. 

e. Posteriormente, faz-se interessante visualizar tais dados em programa de Sistema 

de Informações Geográfico (SIG). Uma vez aberto o ArcMap, deve-se na Barra de 

Ferramentas, clicar em “Arquivo” > “Adicionar Dados” > “Adicionar Dados XY...” 

 

Seleciona-se no campo principal a aba do Excel, contendo as informações 

desejadas. Uma caixa de diálogo será aberta e automaticamente os campos referentes à 

latitude e longitude serão preenchidos. Nota-se aqui que ao selecionar o arquivo Excel 

sempre haverá uma opção de pegar dados de uma planilha hipotética “Estacao”, ou de 

uma mesma planilha “Estação$”. Selecionando a primeira, importa-se apenas valores, 

ignorando fórmulas feitas na planilha Excel, ocasionando assim a eventual omissão de 

dados calculados por funções. No caso da segunda, “Estação$”, é importado o valor de 

saída de cada célula, levando-se em conta a equação. Sugere-se, então, sempre selecionar 

a opção com cifrão, no caso: “Estacao$”. 
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O Sistema de Coordenadas deve ser definido como SIRGAS2000. Desde 25 de 

fevereiro de 2015, segundo primeira resolução da presidência do IBGE/2015, o 

SIRGAS2000 (Sistema de Referência Geocêntrico para as Américas) é o único sistema 

geodésico de referência oficialmente adotado no Brasil. O uso de outros sistemas pode 

causar inconsistências e imprecisões no momento de combinação de dados. Esta medida 

vem a facilitar o intercâmbio de informações nacionais. Sendo assim, todos os arquivos 

utilizados devem ser convertidos a SIRGAS2000, e arquivos criados devem ter sistema 

de coordenadas definido como SIRGAS2000. 

A mensagem abaixo avisa que não há uma coluna com nome ObjectID. O ArcGIS 

necessita dessa para habilitar ações de seleção, consulta, edição de feições, ou definição 

de feições relativas. Clica-se “OK”. Posteriormente, quando se exporta essa mesma 

camada em formato shapefile, o próprio processo cria essa coluna.  

 

 Em seguida, clica-se com o botão direito sobre a camada, “Data”, “Export 

Data...”. Na janela que abrirá, definir o endereço e o nome do arquivo a ser salvo. Depois 

que o arquivo for salvo em shapefile uma janela perguntará se é desejo adicionar o arquivo 

ftp://geoftp.ibge.gov.br/metodos_e_outros_documentos_de_referencia/normas/rpr_01_2015_sirgas2000.pdf
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exportado já no ArcGIS. Pode-se clicar que sim para visualizar e já trabalhar com o 

arquivo. 

 

2.1.3. Seleção das estações de interesse 

Com a bacia já delimitada, pode-se então selecionar as estações da ANA, as PCH, 

CGH e UHE que farão parte do Diagrama Unifilar. Para isso, deve-se clicar em “Selection 

>> Select by Attributes...”. Usa-se  um comando para selecionar todos os pontos de 

mesmo código de sub-bacia. Aqui se selecionaram aquelas de código 86. 

  

 

 Em seguida, clica-se em “Selection >> Select by Location...”. Seleciona-se aqui 

todos os pontos que fazem intersecção com a camada da sub-bacia. Deve-se atentar para 
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manter “add to the currently selected features in” e “intersect the source layer feature” 

selecionados. 

 

 Deve-se tomar cuidado ao realizar essa operação, pois há casos em que as 

coordenadas geográficas das estações fornecidas pela ANA apresentam erros, como por 

exemplo, estações da bacia de interesse localizadas fora da área do polígono e estações 

de outras bacias dentro da área do polígono – situação ilustrada a seguir. 
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2.1.4. Estimar altitude de pontos de interesse via SRTM30 no ArcGIS 

Do MDE pode-se extrair altitude estimada para as estações, os barramentos, e 

qualquer outro ponto de interesse que esteja em formato shapefile. Nesta etapa serão 

utilizados os shapefiles com dados das estações da ANA, aqueles com os dados da 

ANEEL e o modelo digital de elevação SRTM30. 

1. Primeiramente deve-se verificar se a extensão 3D Analyst está ativa e, caso não 

estiver, deve-se ativá-la em “Personalizar” > “Extensões...”: 

 

 

2. Em “ArcToolbox" selecionar “Ferramentas do 3D Analyst” > “Superfície 

Funcional” > “Adicionar Informações da Superfície”. Abrirá assim a seguinte 

caixa de diálogo: 

 

3. Selecionar então como “Classe de Feição de Entrada” um dos shapefiles com 

dados aos quais deseja-se atribuir altitudes. Em “Superfície de Saída” deve-se selecionar 
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o MDE SRTM30 e em “Propriedades de Saída” aparecerá a opção , que deve ser 

assinalada. 

4. Deve-se repetir este procedimento até que os shapefiles da ANA e da ANEEL 

apresentem as altitudes referentes ao MDE SRTM30. Isto pode ser verificado abrindo a 

“Tabela de Atributos” de cada um deles. O procedimento acima acrescentará uma coluna 

“Z” ao final da tabela. 

2.1.5. Processamento de MDE para análise espacial no ArcGIS 

Com o MDE do SRTM30 já mosaicado e pronto para ser utilizado, ativa-se a 

extensão SpatialAnalyst para que se comece a utilizar as ferramentas do ArcHydro. Deve-

se definir o sistema de coordenadas das camadas utilizadas sempre como Datum 

SIRGAS2000. 

Para a montagem do Diagrama Unifilar, faz-se necessário um raster de acumulação 

de fluxo. Portanto, no mosaico deve conter a área de todas bacias que se propõem estudar 

(principalmente bacias a montante, mesmo que elas não sejam objetos de estudo; bacias 

à montante influenciam as áreas de drenagem de estações e usinas presentes no curso de 

rios principal de bacias à jusante). Pode-se observar esse fato no mapa que segue. 
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Qualquer elemento que esteja no rio principal na sub bacia 73 sofrerá influência das 

áreas de drenagem das bacias 72, 71 e 70. Por essa razão, reitera-se a importância em 

utilizar o arquivo do MDE mosaicado por inteiro. 

Apresenta-se aqui o seguinte índice dos passos que hão ser realizados no ArcHydro 

para determinar a área de drenagem da bacia em estudo: 

 

1. FillSinks 

2. Flow Direction 

3. Flow Accumulation 

4. Stream Definition 

5. Stream Segmentation 

6. Catchment Grid Delineation 

7. Catchment Polygon Processing 

8. Drainage Line Processing 

9. Adjoint Catchment Processing 

10. Drainage Point Processing 

11. Batch Point Generation 

12. Watershed Delineation 

 

Antes de tudo, para começar a utilizar o ArcHydro, deve-se definir o destino dos 

arquivos que serão gerados e utilizados nos processos. Para isso, clica-se em “ApUtilities” 

> “Set Target Locations”. Clica-se duas vezes em “HydroConfig”.  

Define-se para os documentos raster uma pasta, de preferência vazia, em que os 

raster serão armazenados. Para salvar os vetores, deve-se criar um Arquivo Geodatabase 

e defini-lo como destino. Recomenda-se que o Arquivo Geodatabase seja criado dentro 

da pasta definida como destino para os arquivos raster. Este procedimento ajuda a evitar 

erros. 
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1. Antes de utilizar o MDE como base para a determinação da bacia, deve-se 

corrigir suas possíveis “falhas”.  

Quando uma célula está circundada por células de maior elevação, os algoritmos 

utilizados no ArcHydro interpretariam que  água drenada até ali ficaria presa nesta célula 

e isso é chamado de “buraco”, ou “depressão”, no Modelo Digital de Elevação. Deve-se, 

portanto, preencher essas depressões. 

Para evitar esse impasse, segue-se “ArcHydro Tools” > “Terrain Preprocessing” > 

“DEM Manipulation” > “FillSinks”. Informa-se o arquivo do MDE (ou, em inglês, 

Digital Elevation Model, DEM) e o ArcHydro criará um arquivo chamado “Fil”. 

Recomenda-se que o arquivo do MDE utilizado seja o menor possível para diminuir 

o tempo necessário para o processamento dos dados. 

 

 

 

2. Prossegue-se com a Direção de Fluxo em “ArcHydro Tools” > “Terrain 

Preprocessing” > “Flow Direction”. Neste caso, deve-se informar o arquivo “Fil” como 
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Modelo Digital de Elevação, no campo Hydro DEM. Será criado então um arquivo 

chamado “Fdr” (Flow Direction). 

 

 

3. Cria-se então o arquivo de Acumulação de Fluxo em “ArcHydro Tools” > 

“Terrain Preprocessing” > “Flow Accumulation”. A Acumulação de Fluxo (“Fac”) é 

desenvolvida a partir da Direção de Fluxo (“Fdr”). 
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4. Prossegue-se com a Definição de Fluxo em “ArcHydro Tools” > “Terrain 

Preprocessing” > “Stream Definition”. Essa ferramenta estima os cursos d’água baseado 

no arquivo de Acumulação de Fluxo.  

Em “Número de Células”, atribuir o limiar que vai definir quais valores de 

acumulação de fluxo serão considerados corpos d’água e quais serão apenas superfície do 

terreno. Isso significa que todas as células do arquivo raster “Fac” que tiverem valor 

superior ao limiar receberão valor 1 (e serão representadas como corpo d’água) e todas 

as outras serão consideradas “NoData”. O valor padrão é o valor recomendado para a 

definição de rios e representa 1% do maior valor de Acumulação de Fluxo. Qualquer 

outro valor pode ser escolhido, lembrando que quanto menor o valor, mais densa ficará a 

rede de cursos d’água resultante, já que mais valores de acumulação serão considerados 

corpos d’água. Isto resultará em um raster com maior nível de detalhamento, já que 

contemplará maior número de corpos d’água. O raster resultante é chamado “Str”.Pode-

se testar os valores de limiar até encontrar o resultado mais satisfatório. 
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5. O próximo passo é a Segmentação dos Cursos d’Água, em que se cria uma grade 

com os cursos d’Água que tenham a mesma identificação. “ArcHydro Tools” > “Terrain 

Preprocessing” > “Stream Segmentation”. O arquivo raster resultante é nomeado 

“StrLnk”. 
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6. Para fazer a delimitação das micro bacias, usa-se a ferramenta “Catchment Grid 

Delineation”. “ArcHydro Tools” > “TerrainPreprocessing” > “Catchment Grid 

Delineation”. Esse procedimento é feito com base no arquivo “StrLnk” e resulta em um 

arquivo raster “Cat”. 

 

 

7. Para vetorizar as micro bacias do arquivo raster “Cat”, clica-se “ArcHydro 

Tools” > “Terrain Preprocessing” > “Catchment Polygon Processing”. O shapefile 

resultante é chamado de “Catchment” pelo ArcHydro. 
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8. Gera-se agora a rede de drenagem em forma de vetor pelo caminho “ArcHydro 

Tools” > “Terrain Preprocessing” > “Drainage Line Processing”. Este processo gera um 

shapefile com o nome “Drainage Line” com base nos arquivos raster “StrLnk” e “Fdr”, 

em que cada linha de drenagem é identificada pela micro bacia a qual pertence.  
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O shapefile criado nesta etapa (“Drainage Line”) servirá de base para a montagem 

do Diagrama Unifilar. 

9. Clica-se então em “ArcHydro Tools” > “Terrain Preprocessing” > “Adjoint 

Catchment Processing” e gerar shapefile “Adjoint Catchment”. Este arquivo apresenta 

também as delimitações das microbacias, mas em um nível de detalhe um pouco maior. 

   

 

10. É preciso então gerar os pontos de exutório das micro bacias para poder 

delimitá-las. Estes pontos são criados em “ArcHydro Tools” > “Terrain Preprocessing” 

> “Drainage Point Processing”. Esta ferramenta utiliza vários dos arquivos criados até 

aqui e cria um shapefile com diversos pontos, cada um correspondendo a uma das micro 

bacias. 
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11. É necessário definir qual dos diversos pontos é correspondente ao exutório da 

bacia de interesse. Isso é feito a partir de “ArcHydro Tools” >  (“Batch Point 

Generation”). Essa ferramenta cria um shapefile chamado “BatchPoint” e habilita o 

cursor para selecionar o ponto de interesse no ArcMap. Clicando no ponto escolhido, 

nomear a bacia correspondente e adicionar uma descrição. Com isso, o shapefile 

“BatchPoint” tem somente o ponto do exutório da bacia de interesse. 

Mais adiante no processo de desenvolvimento do Diagrama Unifilar, utiliza-se 

desta novamente para posicionar alguns pontos de interesse e calcular suas áreas de 

drenagem. 

12. Para completar o procedimento, clica-se em “ArcHydro Tools” > “Watershed 

Processing” > “Batch Watershed Delineation”. Essa ferramenta também utiliza vários 

dos arquivos desenvolvidos até aqui, criando um arquivo chamado “Watershed” onde 

estará delimitada a bacia hidrográfica. 
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2.1.6. Detalhamento das Linhas de Drenagem 

As linhas de drenagem que serão utilizadas como base para o traçado do Diagrama 

Unifilar estão no arquivo “DrainageLine”, criado anteriormente.  

Para complementar as informações, também pode ser útil consultar o arquivo “fac”, 

que pode acrescentar informações mais detalhadas sobre as linhas de drenagem da área. 

Para que o arquivo “fac” apresente informações relevantes, deve-se configurar sua 

exibição clicando com o botão direito do mouse sobre o arquivo e selecionando 

“Propriedades”. Na aba “Simbologia”, selecionar no campo “Mostrar” a opção 

“Classificado”, definir o número de classes e clicar em “Classificar...”. No campo 

“Quebrar valores” deve-se definir as novas classes. Valores com alto grau de detalhe 

podem ser, por exemplo: 50, 100, 150, 200, 250. Os valores podem ser modificados 

novamente de acordo com a necessidade ao longo do processo de montagem do Diagrama 

Unifilar. 

Definir o Rio Principal 

O primeiro passo para montar o Diagrama Unifilar é definir o rio principal da sub-

bacia em questão. Com base na Ottocodificação de bacias hidrográficas, define-se como 

rio principal aquele com maior área de drenagem. Sendo assim, a partir do exutório 

definido nos passos anteriores, deve-se percorrer o traçado de drenagem, de jusante a 

montante, optando-se sempre pelo curso d’água com maior área de drenagem.  

Em caso de dúvida sobre qual das opções de traçado tem a maior área de drenagem, 

seguir este passo a passo: 
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a. Definir um “BatchPoint” em cada um dos trechos e gerar a área de 

drenagem, como feito anteriormente, mas de preferência em um novo 

arquivo. Para isso, basta escolher novos nomes para os campos “Watershed” 

e “Watershed Point”.  

b. Para calcular a área, deve-se clicar com o botão direito do mouse no 

shapefile gerado com as áreas de drenagem e selecionar “Abrir Tabela de 

Atributos”.  

c. Em “Opções da Tabela” ( ) selecionar “Adicionar Campo...”, nomeá-lo 

“Area” e definir como tipo “Duplo”.  

d. Clicar com o botão direito do mouse sobre o cabeçalho do novo campo 

criado e selecionar “Calcular Geometria...”.  

 No campo “Propriedade” definir como “Área” 

 Como “Sistema de Coordenadas”, utiliza-se a projeção Lambert com 

sistema de coordenadas, ou datum horizontal, referenciado ao Datum 

SIRGAS2000 (para isso basta definir este sistema de coordenadas para 

a estrutura de dados – como mostrado na figura abaixo – e marcar esta 

opção para o cálculo da área). 

 No campo “Unidades” é comumente adotado “Quilômetros 

quadrados”, mas neste caso qualquer uma das opções é válida, visto que 

o objetivo é somente comparar as duas opções e definir qual dos trechos 

do rio tem a maior área de drenagem e por isso segue como rio principal. 

Este procedimento deve definir um rio principal, do exutório até a nascente. 



 

 

29 

 

 

Recomenda-se a criação de um novo shapefile contendo apenas o rio principal. Este 

shapefile será utilizado mais adiante no cálculo das distâncias e facilitará a visualização 

durante a montagem do diagrama. É interessante representar este rio com destaque sobre 

o resto dos trechos de drenagem para facilitar. Para que esse rio seja representado por 

uma única linha, ao invés de diversos pequenos segmentos, basta utilizar a ferramenta 

Dissolver em “Ferramentas de Gerenciamento de Dados” > “Generalização” > 

“Dissolver”. 

2.1.7. Projeção para cálculo de áreas (Cônica Conforme de Lambert) 

Para o cálculo de área de polígonos de área de drenagem, pode-se utilizar diferentes 

projeções. A mais adequada para quando se trabalha com grandes bacias em médias 

latitudes é a projeção cônica conforme de Lambert. Utiliza-se essa por ser uma projeção 

também de cone secante (cone que corta o elipsoide, no caso, GRS80, em dois paralelos 

de referência, standard parallels). Isso minimiza distorções. 

Para se adicionar esse sistema de coordenadas no ArcGIS, clica-se com botão 

direito em camadas, “Layers”, e abre-se propriedades, “Properties...”, clica-se em 

“Coordinate system”, clica-se em sistema de coordenadas, “Coordinate System”, 

procura-se por Lambert. Expande-se sistema de coordenadas projetadas, “Projected 
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Coordinate System”, Continental, “Continental”, América do Sul, “South America”, e 

clica-se duas vezes em “South America Lambert Conformal Conic”. 

 

Na janela de “Projected Coordinate System Properties”, definem-se os parâmetros 

da projeção de Lambert. Os valores dos parâmetros que precisam ser necessariamente 

alterados encontram-se nesse sítio. 

Deve-se ainda alterar o sistema de coordenadas geográfico. Para tal clica-se em 

alterar, “Change...”¸ e seleciona-se o sistema SIRGAS2000, cujo código WKID é o 4674. 

Clica-se “OK”. Nota-se que a projeção criada, “Lambert_exemplo”, apareceu na pasta de 

projeções customizadas, “Custom”. Pode-se clicar em seguida em    para se adicionar aos 

favoritos. Por fim, clica-se em OK, e a projeção está definida, pode-se partir para o cálculo 

das áreas. 

 

 

 

https://drive.google.com/open?id=0B08viPHIwmy2OUVpYnNSbXJQYm8
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2.2. Utilizando o QGIS 

O software ArcGIS é bastante utilizado para análises hidrológicas, porém esse 

requer licença. Esta licença é paga e necessita de internet para se manter válida. 

Acreditamos ser interessante ter em mãos um software alternativo porque dinheiro deve 

sempre ser poupado em ambas esferas privada e pública, e não se deve ficar dependendo 

sempre da disponibilidade de internet. É nessa conjectura que nasce esse tópico sobre 

utilização do QGIS para confecção de um Diagrama Unifilar. 

O software QGIS, Quantum Geographic Information System, é semelhante ao 

ArcGIS, porém é um software livre sob a licença de softwares livres GNU GPL, fazendo 

parte do OSGF, Open Source Geospatial Foundation. Ele trabalha principalmente com a 

linguagem Python. 

 

2.2.1. Caminhos relativos no QGIS 

Semelhante ao ArcGIS, há a opção de utilizar caminhos relativos também no QGIS. 

Altera-se nas configurações de projeto, “Project Properties...”, o “Save paths” para 

“relative”, e clica-se “OK”, depois ainda se salva o projeto. Estará salvo então com 

caminhos relativos. 
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2.2.2. Importar Inventário ANA de formato .mdb para QGIS 

Primeiramente se segue o enunciado do item “a.” até “d.” no item 2.1.2 desse 

mesmo tutorial. 

Em seguida, deve-se abrir o arquivo Excel de estações exportado do Access depois 

das consistências feitas, e salvá-lo em formato “.csv” (i.e. “CSV (separado por vírgulas)” 

). 

 

Depois, deve-se abrir o QGIS Desktop, clicar em “Layer”, “Add Layer”, “Add 

Delimited Text Layer...”, ou, clicar no ícone “     ”. 

 

Feito isso uma janela abrirá. Nela, deve-se arrumar algumas configurações. Deve-

se primeiro clicar em “Browse...”, selecionar o arquivo em formato “.csv”, e carregá-lo. 

Em seguida, ajusta-se o “Encoding” para “windows-1252” (esse passo é importante para 

o QGIS reconhecer os caracteres do arquivo, especialmente os acentos das palavras que 

não são comuns a língua inglesa).  

Depois, seleciona-se “Custom delimiters” em “File format”, desmarca-se todos 

delimitadores, adiciona-se em “Other delimiters” o ponto e vírgula, “;”, mantem-se as 
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outras configurações como presentes na imagem abaixo e, por último, mas não menos 

importante, checa-se se os dados parecem estar corretos na tabela de pré-visualização 

(e.g. o que aparece escrito como título da coluna 0 combina com os dados da coluna); é 

sempre bom que se cheque. Finalmente, clica-se ok. 

 

 Em seguida, outra janela abrirá, perguntando qual o sistema de coordenadas de 

referência a ser utilizado pelo QGIS. Como comentado anteriormente nesse tutorial, 

utiliza-se o SIRGAS2000 como sistema oficial de coordenadas geográficas do Brasil. 

Assim, seleciona-se o SIRGAS 2000, de código EPSG: 4674, e clica-se em OK. 

 

Pode-se já visualizar os dados na tela. Esses, porém ainda não estão salvos em 

formato shapefile. Logo então, clica-se com o botão direito no layer, e seleciona-se “Save 

As...”. 
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Outra janela abrirá na qual se especifica as configurações para exportação do 

arquivo para diferentes formatos e outros dados. Nesse caso, gostaríamos que o formato 

exportado seja ESRI Shapefile, pois talvez se venha a utilizá-lo no ArcGIS (programa da 

ESRI que popularizou o formato shapefile, i.e., “.shp”). É importante que em Encoding 

esteja “windows-1252”. Pode-se manter selecionado “Add saved file to map” caso se 

pretenda utilizar/visualizar o shapefile em seguida. Note que o CRS (Sistema de 

Coordenadas de Referência, Coordinate Reference System) escolhido é aquele oficial do 

Brasil, SIRGAS2000. 

 

Caso não se tenha marcado a opção de adicionar o shapefile após exportação, pode-

se ainda adicionar o arquivo shapefile exportado da seguinte maneira: 

Clica-se em “Layer”, “Add Layer”, “Add Vector Layer...”.  
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Uma janela abrirá e nessa deve-se especificar que se adicionará um “File”, de 

Encoding “windows-1252”, clica-se em Browse e abre-se o shapefile salvo. Deve-se 

selecionar o arquivo de formato “.shp”. 

 

Voilà! Lá estará o shapefile pronto para ser utilizado, e com os caracteres 

portugueses devidamente interpretados. 

 

2.2.3. Seleção das estações de interesse 

Após importar os dados, prossegue-se com o recorte dos dados realmente 

necessários para o estudo. No QGIS, pode utilizar as ferramentas seleção por figura por 

equação (1), geométrica (2), e por local, Select by location (3). Faz-se necessário apenas 

que ao utilizar (2) mantenha-se “shift” pressionado para somar à seleção, e que, no caso 

de fazer uso de mais de um método de seleção, usar sempre o de equação primeiro para 

iniciar a seleção porque apenas os outros apresentam opção de “somar a seleção 

existente”. 
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Ao utilizar a opção (3), atenta-se para opção “adding to current selection” para 

adicionar a seleção que está sendo usada. 

 

Clicando-se com o botão direito na camada e em “Save As...”, define-se o local 

onde o arquivo será salvo em “Browse”, depois se marca “Save only selected features” 

como mostrado em imagem abaixo. Assim, serão salvas as feições selecionadas da 

camada em formato “ESRI Shapefile”. 

   

 

2.2.4. Estimar altitude de pontos de interesse via SRTM30 no QGIS 

Faz-se necessário estarem abertos os pontos de interesse dos inventários ANA e 

ANEEL e o raster de MDE. Aqui, utilizaremos um raster derivado do SRTM30. 

Normalmente, o QGIS não possui o plug-in para extrair valores de um raster para 

um shapefile. Para adicionar o plug-in, clica-se em “Plugins”, “Manage and Install 

Plugins...”, 

(2) 

(3) 

(1) 



 

 

37 

 

 

procura-se por “point sampling tool”, clica-se em “Install plugin”. 

 

Uma janela abrirá e com ela o download iniciará 

 

Alguns instantes depois, o plugin estará instalado, e a janela mudará, ficando assim: 

 

Em seguida, clica-se no ícone de “Point sampling tool”. 

 

Uma janela abrirá. Nela, seleciona-se quais os campos que constarão no layer a ser 

criado. Normalmente, seleciona-se todos os campos do layer de estações, os quais estão 

todos com “(source point)” escrito, mais a banda do raster de que se pretende extrair os 

valores de altitude. Também escolhe-se o nome do shapefile de saída. No caso, escolheu-
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se “2017-01-27_Estacoes_SB88_Altitude”. Note aqui que o nome tem mais de 13 letras, 

e embora isso pudesse ser um problema para o ArcGIS, não é  deveras um impeditivo 

para o QGIS. Clica-se então em OK. Abaixo segue imagem: 

 

Note que agora o shapefile de saída é idêntico ao de entrada, com a exceção de 

possuir uma última coluna com o nome do raster utilizado, e os respectivos valores 

extraídos. 

 

Deve-se fazer um adendo aqui que as altitudes extraídas pelo ArcGIS são 

interpoladas, porém, no QGIS, utilizando-se esse método aqui mostrado, as altitudes 

extraídas são do pixel inteiro. Como contornar isso? Recortado o MDE da região, 

reprojeta-se ele com uma resolução maior, e refaz-se o processo de extração de altitudes 

por ponto. 

O processo para extração de valores de um raster qualquer para uma camada de 

pontos qualquer é o mesmo. Sendo assim, para o caso dos barramentos, basta realizar o 

mesmo procedimento, alterando-se a camada para qual os valores do raster será extraido 

na lacuna de “Layer containing sampling points”. 
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2.2.5. Processamento de MDE para análise espacial no QGIS 

Para delimitar uma Bacia Hidrográfica no QGIS, é necessário primeiramente 

possuir um arquivo MDE. Para confecção dos diagramas unifilares, é de praxe utilizar os 

dados de elevação do SRTM30 como comentado acima. Nosso interesse costuma ser 

delimitar uma bacia hidrográfica para calcular a área de drenagem e comparar com o dado 

presente no inventário das estações fluvio e pluviométricas da ANA. O inventário de 

estações da ANA é composto de vários dados enviados por diferentes pessoas, que 

utilizaram diferentes métodos para estimar a altitude, a área de drenagem e a posição real 

de suas respectivas estações. Algumas estações são antigas, e por isso utilizaram métodos 

antigos. Hoje, com o artifício do SRTM30, pode-se aprimorar o processo de consistência 

de dados. Ainda, porém, é evidente que a resolução do SRTM30, e o fato desse ser um 

MDE e não um Modelo Digital de Terreno nos apresenta algumas limitações na análise. 

Além do MDE, também se faz necessário possuir o inventário de estações da ANA 

em formato shapefile. No item 2.2.2 consta como importar dados de uma planilha Excel 

para o QGIS. 

A maneira mais prática de demonstrar o processo é realizando um exemplo. Sendo 

assim, delimita-se em sequência a área de drenagem da estação 70600000, de nome UHE 

Barra Grande Vacas Gordas. 

Adiciona-se, primeiramente, o shapefile das estações e o MDE do SRTM30. Para 

tal, usa-se o atalho “Ctrl+Shift+R”, ou clica-se em “Layer>Add Layer>Add Raster 

Layer...”. 

 

Uma janela abrirá e nela se deve selecionar o arquivo raster em formato “.tif” a ser 

utilizado. Em seguida, clica-se em abrir. 
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Caso se venha utilizar um recém formado mosaico derivado do SRTM30, haverá 

informação desnecessária para os subsequentes processos dispendiosos. Portanto, é sábio 

extrair apenas o espaço do MDE que será utilizado. Como saber que espaço será 

utilizado? Quando se pretende delimitar uma área de drenagem de uma estação, 

hidrólogos costumam ter uma intuição do quão grande essa pode ser e delimitam 

normalmente um espaço, ainda assim, bem exagerado no qual possivelmente consta toda 

a área de drenagem. 

 

É necessário, porém, desenhar essa área a ser extraída no próprio QGIS. Portanto, 

criaremos na sequência um shapefile. Clica-se tanto “Ctrl+Shift+N”, ou “Layer>Create 

Layer>New Shapefile Layer...”. 

 

Uma nova janela abrirá. Nela se define que o tipo de shapefile será um “Polygon”, 

de Encoding “windows-1252”, de coordenadas geográficas “SIRGAS-2000”, cujo código 

EPSG é 4674, e clica-se Ok. 
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Em seguida, outra janela abrirá, perguntando em que local deve ser salvo esse novo 

Shapefile. Sugere-se salvar em algum local de fácil acesso, com algum nome como 

“para_extração” ou “extrair”. Esse Shapefile poderá ser depois de usado prontamente 

deletado. Esconlhendo-se o nome e salvando-se ele, o mesmo aparecerá no canto 

esquerda em Layers Panel. 

Para desenhar a feição, clica-se com botão direito no layer e seleciona-se “Toggle 

Editting”. 

 

 Depois, clica-se em Add Feature. Caso não conste essa opção na barra de 

ferramentas no topo da janela principal, deve-se clicar com o botão direito na parte cinza 

no topo e selecionar “Digitizing Toolbar”. 
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Clicando-se em Add Feature, deve-se agora desenhar a feição a ser extraída do 

MDE. Para desenhá-la, clica-se com o botão esquerdo um a um, adicionando-se vértices 

à feição. Completado o desenho, clica-se com o botão direito para o programa saber que 

a feição está desenhada. 

 

Uma janela abrirá perguntando qual o “id” dessa feição. Quando se pretende 

desenhar mais feições, é importante adicionar um código para diferenciar as feições, 

examinando a tabela de atributos do layer. Dado que usaremos apenas uma feição para 

extração, pode-se tanto não escrever nada, como botar algum número. 
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 Agora, deve-se salvar as edições feitas. Clica-se, portanto, em “Save Layer Edits”. 

Por fim, deve-se sair do modo de edição do Layer. Para tal se clica em “Toggle Editting” 

que está ao lado esquerdo de “Save Layer Edits”. 

 

 Prossegue-se com a extração do MDE pelo Layer criado. Clica-se em 

“Raster>Extraction>Clipper...”. 

 

 Abrirá uma janela, na qual se define qual o raster que sofrerá a extração, o local 

onde essa extração será salva, e se o modo de extração será dado por Extent ou Mask 

layer. Abaixo consta imagem. É bastante importante garantir que “Crop the extent of the 

target dataset to the extent of the cutline” esteja marcado, do contrário gerar-se-á um 

raster de mesma extensão que o original, com vários pontos “sem data”, NoData. 

Deu-se o nome de “MDE30_SRTM_extraido” para o arquivo de saída. Clica-se em 

OK. 
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 Caso apareça uma mensagem de erro com a notificação “Output driver 'GMT' not 

recognised or does not support direct output file creation.”, altera-se o código 

programacional. Para isso, depois de definir todas configurações do processo, clica-se no 

icone de edição (Edit) de lápis laranja, e altera-se o código programacional de “-of GMT 

para “-of Gtiff”. 

 

 O processo costuma ocorrer de maneira bem rápida mesmo para bacias grandes, 

dependendo o tempo de processo do raster de entrada (tamanho do pixel, número de 

pixels, do tipo de data – string, float, double, integer) e do número de vértices do polígono 

usado como Mask Layer. Caso seu processo esteja demorando muito mais de 6 minutos, 

pode ser que tenha se esquecido de marcar “Crop the extent of the target dataset to the 

extent of the cutline”. 

 

Assim como no ArcGIS, agora serão feitas diversas operações para criar layers de 

direção de escoamento e de acumulação de escoamento. Para tal, utilizar-se-á algoritmos 
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do SAGA, System for Automated Geoscientific Analyses, (2.1.2) e do GRASS, 

Geographic Resources Analysis Support System. Ambos são programas livres de GIS, 

cujos algoritmos foram adicionados na ferramenta de processo do QGIS (pode-se dizer 

que é um “ArcToolBox do QGIS”) . 

 Primeiro, adiciona-se a Processing Toolbox, na qual se encontra os algoritmos dos 

SAGA e GRASS. Pode-se clicar também “Ctrl+Alt+T”, ou clica-se em “Processing” e 

depois em “Toolbox”. 

 

Feito isso, expande-se o “SAGA (2.3.2)”, “Terrain Analysis – Hydrology”, e depois 

duplo clique em “Fill Sinks xxl (wang & liu)”. Semelhante ao processo do 

ArcHydroTools, o “Fill Sinks xxl (wang & liu)” preencherá depressões. Se isto não fosse 

feito, os algoritmos, ou processos, posteriores interpretariam que a água ficaria estagnada 

eternamente nessas tais depressões. 

 

Para mais informações sobre esse processo, desenvolvido por Wang & Liu, pode-

se acessar este sítio:  

Esse processo é tipicamente utilizado para bacias maiores, por isso o nome de “xxl”. 

Caso queira-se trabalhar com bacias menores, pode-se empregar o “Fill Sinks (wang & 

liu)”, que é mais completo, apresentando como dados de saída não só o MDE sem 

depressões, como também um raster de direção de escoamento (Flow directions) e de 

bacias hidrográficas (Watershed basin). Mais informações no sítio: 

http://www.saga-gis.org/saga_tool_doc/2.2.5/ta_preprocessor_5.html
http://www.saga-gis.org/saga_tool_doc/2.1.3/ta_preprocessor_4.html
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Dando-se duplo clique em “Fill Sinks xxl (wang & liu)”, abre-se uma janela na qual 

se define qual raster terá suas depressões preenchidas, e qual a mínima declividade que 

é considerada uma depressão. Utiliza-se o valor padrão de 0.01.  

 

Em seguida, prossegue-se com os processos para obter a direção de escoamento e 

acumulação de escoamento. Para tal é usado o algoritmo “r.watershed”. O dado de 

entrada será o DEM com as depressões preenchidas que foi gerado pelo algoritimo 

anterior. Em “minimum size of exterior watershed basin”, utiliza-se um valor de 1000. 

Esse parâmetro determina o tamanho mínimo considerado pelo algoritimo como sendo 

uma bacia individual, mas já que não estamos interessados no dado de saída “Basin”, 

apenas queremos que o programa não tranque, e por isso o valor de 1000 é adequado. Às 

vezes pode ser necessário um valor maior para evitar que o algoritmo colapse. 

Mantém-se marcado apenas “Number of cells that drain through each cell”, 

“Drainage direction” e “Stream segments”. O primeiro retorna a acumulação de 

escoamento, o segundo a direção do escoamento, e o terceiro os cursos de água. Sugere-

se clicar nas reticências para salvar os arquivos gerados (Save to file). O “Stream 

segments” é especialmente importante que seja salvo. Clica-se, por fim em “Run”. 

 

Esse processo não levou mais de 6 minutos. Normalmente, o layer de escoamento 

acumulado (“Number of cells that drain through each cell”) não é gerado com uma boa 
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simbologia, não sendo assim visualizável. Esse, porém, é bastante importante para 

definirmos corretamente o ponto do exutório referente à área de drenagem a ser calculado. 

Portanto, abre-se as propriedades do raster de escoamento acumulado. 

 

Em “Style”, expande-se em “Load min/max values”, seleciona-se “Mean +/- 

standard deviation x 2,00”. Esse processo define novos valores de mínimo (média dos 

valores de todas as células do raster menos dois desvios padrões) e máximo (média dos 

valores de todas as células do raster mais dois desvios padrões) para uma simbologia em 

gradiente de preto até branco, sendo mais escura a célula com baixo número de 

escoamento acumulado, e mais clara aquela com grande número de escoamento 

acumulado.  

Clica-se logo abaixo em “Load”, e depois em “Apply”. Dessa maneira, o raster será 

mais bem visualizado.  

 

Em seguida, localiza-se a posição da estação de interesse. Nesse caso, a 70600000. 

É notável que a estação não está exatamente sob a célula em que se concentra a 

drenagem (ou, no caso, onde “possivelmente” se encontra o curso d’água). Pode-se 

utilizar aqui também a camada salva de “Stream Segments”. 
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Em seguida, utiliza-se o “r.water.outlet”. Como dado de entrada, seleciona-se o 

raster de direção de escoamento (Drainage direction), o qual foi gerado no processo de 

“r.watershed”. É também necessário apontar qual ponto deverá ser considerado o exutório 

dessa área de drenagem. Há um recurso nesse processo que consiste em clicar na 

reticência à direita da lacuna de “Coordinates of outlet point(x,y)”. Clica-se na reticência.  

 

A janela do algoritmo se minimiza. Em seguida, clica-se na célula do curso d’água 

mais próxima da estação. Porém, qual célula é essa? As vezes é facilmente possível ter 

uma ideia no simples olhar, mas em outras a ferramenta  pode ser bastante útil para 

medir a menor distância do ponto de interesse até a drenagem. Com essa ferramenta 

também é possível medir, a grosso modo, a área de drenagem da estação, dado que a 

projeção utilizada esteja em metros e seja condizente com a área (2.2.7). Escolhendo o 

ponto na drenagem, a mesma janela anterior aparece novamente. 
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Note que agora a coordenada (x,y) já consta na lacuna. Clica-se então em “Run”. 

Pronto, em poucos segundos o raster da bacia é gerado.  

Porém, ainda falta transformar esse arquivo raster em formato shapefile. 

Felizmente, há um algoritmo chamado “r.to.vect” no próprio  grupo  de algoritmos do 

GRASS. 

Abrindo o “r.to.vect”, adiciona-se como dado de entrada o raster da área de 

drenagem calculada como “Input raster layer”, define-se “area” como “Feature type”, e, 

dependendo da aplicação, seleciona-se “Smooth corners of area features”. Quando o 

objetivo for calcular a área segundo o SRTM30, considerando a resolução de 30 metros, 

sugere-se manter essa última opção desmarcada porque quando marcada essa tem caráter 

tão puramente estético (i.e. essa opção quando marcada suaviza o raster). 

Clica-se então em “Run”. Esse processo é bastante rápido e não levou mais de 20 

segundos. Abaixo segue imagem da janela já configurada. 

 

 Voialà! Pode-se visualizar a área de drenagem. 
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O usuário mais atento, deve ter notado desde o processo de “r.watershed” que gera 

os layers de direção de escoamento e acumulo de escoamento, os layers criados estavam 

em EPSG:4140, e o shapefile de área de drenagem gerado está em EPSG:4019. Já que 

pretendemos trabalhar com o SIRGAS2000, agora, por fim, exporta-se o shapefile no 

sistema de coordenadas SIRGAS2000. 

Para tal, em “Layers Panel”, clica-se com o botão direito no shapefile gerado, 

seleciona-se “Save As...”. 

 

 A seguinte janela abrirá, e nela deve-se especificar o “Format” como “ESRI 

Shapefile”, definir o endereço em que o aquivo será salvo (clicando-se em “Browse”), 

manter como “CRS” o “Project CRS (EPSG:4674 - SIRGAS 2000)”. Mantem-se o 

Encoding como “windows-1252” por ser esse bom para interpretar caracteres 

portugueses, e também seleciona-se “Add saved file to map”. 
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2.2.6. Detalhamento das Linhas de Drenagem 

Abre-se o arquivo de cursos d’água, Stream segments, o qual foi gerado no item 

2.2.5. Abre-se o algoritmo r.thin do GRASS, e, definindo-se um limite de 200 interações 

para o algoritmo, e salvando-se (reticências) na lacuna abaixo de “Thinned”, clica-se em 

Run. 

 

Em seguida, utiliza-se novamente o r.to.vect do GRASS para vetorizar o raster 

gerado. Dessa vez, porém, seleciona-se “line” para Feature type, e escolhe-se um local 

seguro para salvar o vetor gerado (lacuna em baixo de Vectorized). 

Definir o Rio Principal 

O primeiro passo para montar o Diagrama Unifilar é definir o rio principal da sub-

bacia em questão. Com base na Ottocodificação de bacias hidrográficas, define-se como 

rio principal aquele com maior área de drenagem. Sendo assim, a partir do exutório 

definido nos passos anteriores, deve-se percorrer o traçado de drenagem, de jusante a 

montante, optando-se sempre pelo curso d’água com maior área de drenagem, ou ainda, 

com maior acumulação de escoamento (pode-se utilizar simples o raster de acumulação 

de escoamento).  

Em caso grandes dúvidas sobre qual das opções de traçado tem a maior área de 

drenagem, deve-se utilizar o r.outlet do GRASS, utilizando também o arquivo de direção 

de escoamento já gerado no item 2.2.5. 

Seleciona-se de um em um os segmentos de rio até a nascente, utilizando a 

ferramenta identificar (    ) e as ferramentas de seleção descritas em 2.2.3 . Salienta-se 

aqui que se deve manter o botão shift durante o processo. Recomenda-se a criação de um 

novo shapefile contendo apenas o rio principal no final. Este shapefile será utilizado mais 

adiante no cálculo das distâncias e facilitará a visualização durante a montagem do 

diagrama. É interessante representar este rio com destaque sobre o resto dos trechos de 
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drenagem para facilitar. Para salvar o selecionado como shapefile, clica-se com o botão 

direito sobre a camada, seleciona-se “Save as” e marca-se “Save only selected features”. 

    

2.2.7. Projeção para cálculo de áreas (Cônica Conforme de Lambert) 

Para o cálculo de área de polígonos de área de drenagem, pode-se utilizar diferentes 

projeções. A mais adequada para quando se trabalha com grandes bacias em médias 

latitudes é a projeção cônica conforme de Lambert. Utiliza-se essa por ser uma projeção 

também de cone secante (cone que corta o elipsoide, no caso, GRS80, em dois paralelos 

de referência, standard parallels). 

Para se adicionar esse sistema de coordenadas no QGIS, é necessário criar um 

“Custom CRS”. Clica-se em “Settings”, “Custom CRS...”. 

 

Uma janela abrirá. Nela, clica-se no símbolo de “ + ”. Define-se o nome da projeção 

(Name). Sugere-se digitar algo que inicie por “Lambert_” e acabe com a bacia que está 

se propondo a calcular a área de drenagem. Em Parameters, deve-se digitar o código 

referente à projeção Lambert daquela bacia.  

Abaixo segue exemplo do código digitado para Sub-Bacia 85, e uma breve 

explicação de cada comando utilizado na linguagem proj.4. 
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+proj=lcc +lat_1=-28.584 +lat_2=-30.364000000000004000  

+lat_0=-9.254833333333330000 +lon_0=-53,119999999999997000 

+x_0=0 +y_0=0 +ellps=GRS80  

+towgs84=0.48,0.49,-0.3,0,0,0,0  

+units=m +no_defs 

Segue explicação breve dos códigos: 

+proj=lcc   (define que a projeção é Lambert Conformal Conic) 

+lat_1=  (define o primeiro paralelo) 

+lat_2= (define o segundo paralelo) 

+lat_0= (define a latitude de origem) 

+lon_0= (define o meridiano central) 

+x_0=  (define o falso leste) 

+y_0=  (define o falso norte) 

+ellps=GRS80 (define o elipsoide de origem) 

+towgs84=0.48,0.49,-0.3,0,0,0,0 (define a relação com o DATUM wgs84) 

+units=m (define que as unidades serão representadas em metros) 

+no_defs (define que nenhuma opção “default” será lida dos arquivos “default”. 

Algumas vezes, a omissão desse comando pode causar erros surpreendentes como 

consta aqui) 

Os valores desses parâmetros para cada Sub-Bacia podem ser obtidos no seguinte 

sítio. Nesse mesmo sítio também consta breve explicação para a estimativa desses 

parâmetros. 

Mais informações sobre a projeção cônica conforme de Lambert podem ser obtidas 

na página 104 do Map Projections – A working manual, o qual está disponível nesse sítio.  

http://lists.osgeo.org/pipermail/mapserver-users/2003-November/046863.html
https://drive.google.com/open?id=0B08viPHIwmy2OUVpYnNSbXJQYm8
https://pubs.usgs.gov/pp/1395/report.pdf
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 Depois de criada a projeção exata a ser utilizada para calcular a área com menor 

deformação, clica-se no canto inferior direito para alterar o sistema de projeção. 

 

Uma janela abrirá. Nela, procura-se a nova projeção adicionada. Aqui, no caso, deu-

se o nome de “Lamber_SB_85” porque com essa projeção calculou-se a área de drenagem 

não só da Sub-Bacia 85, como também de outras estações que nela encontravam. Para 

facilitar a busca, pode-se utilizar o “Filter”: esse consiste em localizar projeções segundo 

a palavra título. Projeções adicionadas pelo usuário aparecem na categoria “User defined 

Coordinate Systems”. Aqui se filtrou por “Lambert”. Seleciona-se a projeção, e clica-se 

em “Ok”. Segue imagem abaixo. 

 

2.2.8. Simbologia no QGIS 

Os autores desse trabalho desenvolveram uma simbologia para os diagramas 

unifilares também no QGIS. A simbologia foi salva em formato “.qml”, que é análogo ao 

formato “.lyr” do ArcGIS.  

Sido adicionado o shapefile de estações, clica-se com o botão direito no layer e 

seleciona-se “Properties”. 
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Depois, em “Style”, clica-se em “Load Style” e deve-se localizar o aquivo “.qml”. 

Localizando-lo, abre-se esse e, clica-se então em OK. Essa simbologia pode ser um tanto 

pesada, e por isso demorar bastante para carregar. Depois de carregada, deve parecer 

semelhante a imagem abaixo: 

  

Nessa simbologia, quando aparecer um ponto rosa, deve-se identificar esse ponto e 

entender o porque ele não foi lido pela simbologia. Pontos rosa são estações que não 

medem nem chuva, nem nível de água, ou apresentam alguma categoria incompreendida 

pelo código de simbologia desenvolvido pelos autores desse tutorial. 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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As estações em questão são da Sub Bacia 85. A estação 03052015, de nome 

Encruzilhada do Sul – Ipagro, que está representada de rosa está marcada como 

desativada, e não possui de início e fim de série histórica, como todas estações desativadas 

normalmente apresentam. Sendo assim, não é possível definir qual o tipo dessa estação, 

e por isso ela é um ponto rosa no mapa, o qual pode ser excluído. 

Semelhantemente, faz-se o mesmo para os dados da ANEEL. 

Os arquivos “.qml” estão nos seguinte sítios abaixo: 

Simbologia para Estações: sítio. 

Simbologia para UHE: sítio. 

Simbologia para PCH: sítio. 

Simbologia para CGH: sítio. 

Para a simbologia funcionar, é necessário que o QGIS esteja lendo as camadas no 

mesmo código que foram escritas. Camadas do Governo Federal costumam estar sempre 

escrita em código UTF-8. Pode-se checar o código que o QGIS está considerando para 

determinada camada simplesmente por acessar as propriedades, clicar em “General” e 

depois arrumar “Data source encoding” para UTF-8. 

3. Diagrama 

3.1 Visualização no SIG 

Primeiramente, deve-se ativar no ArcGIS/QGIS as camadas: 

– UHE 

– PCH 

– CGH 

– Estações Hidrométricas 

– Rio Principal  

– Linha de Drenagem 

– Municípios 

– Camada da Sub-bacia 

Para continuação do trabalho e eventuais atualizações, sugere-se salvar um arquivo 

.mxd, com o nome “DigramaUnifilarSBXX”. Consoante figuras abaixo, pode-se ter uma 

noção da quantidade de informação que deverá ser colocada no diagrama e quais possíveis 

https://drive.google.com/open?id=0B08viPHIwmy2V3drUzdrU2JySGM
https://drive.google.com/open?id=0B08viPHIwmy2dUhRcjN4MDV0ZTA
https://drive.google.com/open?id=0B08viPHIwmy2SU4zU0pSSDdrakE
https://drive.google.com/open?id=0B08viPHIwmy2OFdneGxTdndqWGc
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divisões serão feitas. A primeira figura apresenta a visualização no ArcMap, a segunda, 

no QGIS. 

 

 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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3.2 Estimar a área de drenagem das estações fluviométricas, UHE, 

PCH e CGH via SRTM30 

Lembrando que as estações fluviométricas da ANA e as PCH, UHE e CGH da 

ANEEL devem estar todas sobre trechos de rio, começa-se no ArcMap a definir os “Batch 

Point”, utilizando o ArcHydro (2.1.5). A principio os “BatchPoint” devem ser colocados 

no trecho de rio mais próximo dos pontos do inventário, e isso pode ser verificado 

utilizando a ferramenta “Medida” do ArcGIS, representada por este símbolo:     . . Este 

procedimento é bastante simples, porém vale lembrar que os nomes dados aos 

“BatchPoint” devem ser coerentes e representativos em relação a estação que 

correspondem.  

Para evitar retrabalho, também auxilia muito observar a área de drenagem que a 

ANA ou ANEEL disponibilizam para as estações que estão sendo representadas pelos 

“BatchPoint”, pois estas podem indicar qual trecho de rio tem maior probabilidade de ser 

o correto local da estação. Utilizado    , e valendo-se de um pouco de foto interpretação, 

pode-se medir uma “provável área de drenagem” da estação sobre o MDE.  

Prossegue-se depois com os passos 11 e 12 de 2.1.5 para estimar as áreas. 

No QGIS, utilizando os processos descritos em 2.2.5, gera-se a camada de área de 

drenagem, em seguida se adiciona a projeção a ser utilizada, descrito em 2.2.7. Então, 

clica-se em “Vector”, “Geometry Tools” e “Export/Add geometry columns”. 

 

 Uma janela abrirá. Nela se seleciona qual a feição, ou camada (layer), cuja área 

será calculada. Também se define qual sistema de projeção será utilizado. Aqui se usa 

“Project CRS”, que, no caso, é nada menos do que a projeção criada. Uma nova feição 

será gerada, e nessa estarão os dados de área. Essa, porém, não será salva a menos que o 

usuário clique nas reticências ao lado de “Create temporary layer”, e clique em “Save to 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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file”, definindo em sequência um local onde salvar essa feição a ser criada. Clica-se em 

“Run”. 

 

Com o processo acabado, abre-se a tabela de atributos (Open Attribute Table) da 

feição gerada. 

 

Podem-se notar duas novas colunas, as quais estão respectivamente em metros 

quadrados (Área) e metros (Perímetro). Aqui se utilizou a camada da bacia 85 como 

exemplo. 

 

Há um impasse, porém: impossibilidade de calcular a área de drenagem para vários 

pontos de uma só vez. Há a opção de se utilizar o “Batch Process” no algoritimo de 

“r.water.outlet”, porém é necessário saber de antemão todas coordenadas (x,y) dos postos 

já corrigidos para cima da linha de drenagem, e digitá-las uma a uma. Pode-se anotar uma 

a uma num documento de texto para auxiliar no processo, por exemplo. 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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3.3 Montagem no Microsoft Word 

O rio principal é representado no Diagrama Unifilar com uma linha azul (RGB: 

0,0,255) de espessura igual a 1pt. Seus afluentes, de mesma cor, apresentam espessura de 

0,75pt. Os afluentes destes corpos d’água também são representados com a mesma cor, 

mas com espessura de 0,5pt. Caso existam ainda outros afluentes nestes corpos d’água, a 

espessura não deve diminuir; continua com mesma cor e espessura igual a 0,5pt. Os 

corpos d’água devem ser identificados com seu respectivo nome e direção de fluxo, 

representada por uma flecha também. Os nomes podem ser encontrados no shapefile de 

hidrografia da ANA. 

É interessante utilizar o Hidro para classificar as estações, já que este software 

apresenta as informações de forma mais simplificada. A legenda será explicada com base 

no layout do Hidro. 

Durante a construção do diagrama, é aconselhável já colocar caixas de texto com o 

tamanho e cor de letra corretos para mais adiante acrescentar os valores de distância entre 

estações, entre nascente e afluente(s), entre afluentes, entre barramentos, etc. Estes 

valores serão calculados em uma etapa posterior e o processo de preenchimento fica mais 

simples quando já existem no diagrama os espaços necessários.  

Durante a primeira parte da construção do diagrama ainda não se tem os valores de 

área de drenagem do SRTM30, mas convém deixar indicado dentro do símbolo das 

estações um espaço para acrescentar esta informação. 

 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar


 

 

6 

 

Com esta configuração e com estes dados, as únicas informações faltantes serão as 

distâncias entre os elementos e as áreas de drenagem das estações fluviométricas e 

barramentos. 

Um ponto importante que se deve observar são os rótulos, labels. Esses podem 

auxiliar bastante para a montagem do diagrama. Pode-se configurar para que informações 

apareçam na própria tela de visualização, poupando assim a necessidade de abrir a tabela 

de atributos incessantemente para checar informações. Para tal, abrem-se as propriedades 

da camada, clica-se na aba Rótulos e depois em “Expressão...” 

 

Escreve-se então a expressão desejada para que os campos que se quer visualizar 

apareçam no mapa. Entre cada campo usa-se a expressão “ & vbnewline &” para iniciar 

nova linha. 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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Exemplificando-se: para as estações da ANA (pluviométricas e fluviométricas) a 

expressão que exibe o código, o nome, a altitude do próprio inventário, e a altitude 

estimada via SRTM30 da estação é a seguinte: 

[Codigo] & vbnewline & [Nome] & vbnewline & [Altitude] & vbnewline & [Z] 

Quanto as PCH, UHE e CGH, a expressão que exibe o nome da AHE, a área de 

drenagem, a altura estimada via SRTM30, e o estágio em que ela se encontra é: 

[NOME] & vbnewline & [AREA_DREN] & vbnewline & [Z] & vbnewline & [ESTAGIO]] 

No QGIS, para exibir rótulos, labels, semelhante processo é seguido. Abaixo segue 

sequência de imagens. 

 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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Clica-se no símbolo Épsilon (     ). 

Ainda na imagem acima também se pode alterar outras configurações da legenda 

como a disposição dela (Placement), o formato do texto (Formatting), o estilo e tamanho 

do texto (Text) e outros. 

Em seguida, seleciona-se então os campos que se pretende exibir na desejada 

ordem, sendo espaçados pelo comando “||  '\n'  ||”. Em suma, o processo é praticamente 

o mesmo, mas a linguagem utilizada pelo QGIS é um pouco diferente. Auxilia bastante 

expandir em “Fields and Values” (1), realizar duplo-clique no campo desejado (2), e 

utilizar (3) e (4) para adicionar o “||  '\n'  ||”. Em (5) se pode ter uma prévia da expressão 

que está se digitando. 

 

3.4 Definição Legenda Diagrama 

3.4.1   Dados da ANA 

A simbologia do diagrama será explicada com base no formato Hidro, que auxilia 

na visualização das informações do inventário da ANA. Segue um exemplo do formato: 

(5) 

(1) (3) (4) 

(2) 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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Optou-se por dar preferência às coletas de dados ativas, que são representadas no 

Hidro pelo preenchimento das caixinhas com este símbolo: . Quando a caixinha estiver 

preenchida, haverá somente a data de início de coleta do dado. Sempre que houver uma 

data de fim, significa que este tipo de medição foi desativado. 

3.4.1.1  Estações Fluviométricas  

 

1) Forma 

a. Estações fluviométricas que apresentarem data de início no campo “Descarga 

Líquida (D)” são classificadas como “Estação Fluviométrica com Medição de 

Descarga (FD)” e são representadas por um triângulo: 

 

 

 

 

b. Estações fluviométricas que não apresentarem data de início no campo “Descarga 

Líquida (D)”, mas somente no campo “Escala (F)”, são consideradas “Estação 

Fluviométrica Linimétrica (F)” e são representadas por um retângulo: 

 

 

Data de Início 

Data de Fim 

 

Código 
Nome 
Área 
Área 

Altitude 
Altitude 

 

Extraído do 

inventário ANA 

Estimado via 

SRTM30 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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2) Contorno – linha 

a. Caso alguma das opções de medição em “Coleta/Período” apresente o símbolo     , 

a estação deve estar ativa. Sendo assim, ao menos uma das características da estação 

terá apenas data de início. Estações ativas tem como traço do contorno uma linha 

contínua, de preferência com espessura 0,75pt:  

b. Caso nenhuma das opções de medição tenha o símbolo      , significa que a estação 

está inativa. Sendo assim todos os campos que apresentam data de início, terão 

também data de fim. Estações inativas são representadas com traço pontilhado no 

contorno, de preferência com espessura de 0,75pt:  

3) Telemetria: 

Quando uma estação ativa for telemétrica (apresentando apenas data de 

início e o símbolo     ) ou quando uma estação inativa foi telemétrica (todas as 

medições da estação, inclusive a telemetria, têm data de fim e nenhuma tem o 

símbolo     ) acrescenta-se um T no canto direito superior do símbolo, com a 

mesma cor do contorno, como mostrado abaixo: 

 

 

 

 

4) Registrador de nível: 

Se uma estação ativa possuir Registrador de Nível (Fr) (tem o símbolo     e 

apenas data de início) ou se uma estação inativa apresentar Fr (todas as medições 

da estação, inclusive o Registrador de Nível, têm data de fim e nenhuma tem o 

símbolo   ) acrescenta-se uma linha diagonal por trás do símbolo, com a mesma 

cor do contorno, como mostrado abaixo: 

 

 

 

Código 
Nome 
Área  
Área 

Altitude 
Altitude 

Código 
Nome 
Área  
Área 

Altitude 
Altitude 

T 
Código 
Nome 
Área  
Área 

Altitude 
Altitude 

T 

 

Código 
Nome 
Área  
Área 

Altitude 
Altitude 

 

T 

 

Código 
Nome 
Área  
Área 

Altitude 
Altitude 

 

T 

 

Código 
Nome 
Área  
Área 

Altitude 
Altitude 

 
 

Código 
Nome 
Área  
Área 

Altitude 
Altitude 

 

Estimado via 

SRTM30 Extraído do 

inventário ANA 
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5) Contorno – cor 

a. Quando a entidade operadora da estação for o SGB, como o exemplo acima, o 

contorno do símbolo é colocado na cor preta. O código de operadora do SGB é 

00082. 

 

b. Quando a operadora da estação for qualquer outra entidade (código diferente de 

00082) como em exemplo mostrado acima, o contorno do símbolo será da cor 

vermelha. 

 

3.4.1.2  Estações Pluviométricas 

 

1) Ativas e Inativas 

a. Estações pluviométricas ativas (com ao menos uma das medições 

marcadas com o símbolo      ) são representadas por círculo totalmente 

preenchido da mesma cor do contorno: 

 

 

b. Estações pluviométricas inativas (sem medições marcadas com o símbolo     

) são representadas por um círculo com preenchimento branco e contorno 

com traço de ponto quadrado: 

 

 

2) Registrador de Nível 

a. Estações pluviométricas ativas com Registrador de Chuva (Pr) também 

ativo recebem uma linha diagonal: 

 

Código 
Altitude ANA 

Altitude SRTM30 
 

Código 
Altitude ANA 

Altitude SRTM30 
 

Código 
Altitude ANA 

Altitude SRTM30 
 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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b. Estações pluviométricas inativas com Registrador de Chuva (Pr), 

apresentando data de início e fim, recebem uma linha diagonal: 

 

 

3) Telemetria 

a. Quando uma estação pluviométrica ativa for telemétrica, acrescenta-se um 

T à direita superior do círculo: 

 

 

b. Se uma estação pluviométrica ativa foi telemétrica, acrescenta-se também 

um T à direita do círculo: 

 

 

4) Entidade operadora 

a. Quando a entidade operadora for o SGB, a estação pluviométrica é 

representada na cor preta. 

 

 

 

b. Quando a entidade operadora não for o SGB, a estação pluviométrica é 

representada na cor vermelha. 

 

 

3.4.1.3  Sistema de Acompanhamento de Reservatórios (SAR) 

O Sistema de Acompanhamento de Reservatórios (SAR) da ANA compreende os 

reservatórios destinados a diferentes usos, incluindo a geração de energia. Contudo, nos 

diagramas unifilares construídos serão plotados com a simbologia abaixo apenas os 

reservatórios que não forem de uso do sistema elétrico (ANEEL/SIGEL). Esses 

reservatórios são representados no diagrama por um losango com a base menor aberta, 

cujo posicionamento depende da direção de fluxo do rio. 

 

Código 
Altitude ANA 

Altitude SRTM30 
 

T 

 

T 
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3.4.2   Dados SIGEL 

A informação mais importante para a simbologia dos dados do SIGEL é o estágio 

em que os empreendimentos se encontram. É com base nestes estágios que a simbologia 

é definida.  

Abaixo estão os estágios de AHE, Aproveitamentos Hidro Elétricos, (CGH, PCH, 

UHE) na ordem da implantação, construção e operação, considerando que não haja 

impasses durante o processo: 

1.Eixo Inventariado 

2.EVTE em Elaboração 

3.EVTE Aceito 

4.EVTE Aprovado 

5.PB em Elaboração 

6.PB Aceito 

7.PB Aprovado 

8.DRI 

9.DRS 

10.Construção não iniciada 

11.Construção com Outorga 

12.Operação 

13.Revogado 

14.Desativado 

15.Extinta 

Os estágios estão foram atualizados no dia 21 de Novembro de 2017 no tutorial 

quando a mudança foi notada pela equipe. 

3.4.2.1  PCH  

PCH (Pequena Central Hidrelétrica) são usinas hidrelétricas de pequeno porte, cuja 

capacidade instalada encontra-se entre 1MW (um megawatt) e 30MW (trinta megawatts) 

e cuja área de reservatório não ultrapassa 3 km² (300 ha), ou assim definidas pela ANEEL, 

conforme Resolução nº 652 de 09 de dezembro de 2003. 

No Diagrama Unifilar elas são representadas por um triângulo cujo posicionamento 

depende da direção do rio. As cores e contornos dependem do estágio das PCH. 

a. Quando a PCH estiver entre os estágios 1 e 8, considera-se em “PCH em estudo 

para implantação” e representa-se assim: 

 

b. Quando a PCH estiver no estágio 9 ou 10, considera-se em “PCH com outorga 

para implantação” e representa-se assim: 

 

 

SAR Nome 
Área de drenagem SRTM30/ 

Altitude SRTM30 
 

SAR Nome 
Área de drenagem SRTM30/ 

Altitude SRTM30 
 

PCH Nome 
Área Drenagem ANA /SRTM30 / Altitude SRTM30 

PCH Nome 
Área Drenagem ANA /SRTM30 / Altitude SRTM30 
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c. Quando uma PCH estiver entre os estágios 11 e 12, classifica-se como “PCH em 

Operação ou Construção – Reservatório Menor ou Igual a 3km²” e representa-se 

assim: 

 

d. Considera-se o estágio 13 (revogado) um retorno à etapa de estudo e, portanto, 

segue-se a mesma classificação do item a. 

e. Ainda há o estágio 14 que indica o estado desativado ou extinta. Esse, porém, é 

bastante raro e representa-se assim: 

 

3.4.2.2  CGH 

CGH (Central Geradora Hidrelétrica) são unidades geradoras de energia com 

potencial hidráulico igual ou inferior a 1 MW (um megawatt), normalmente com 

barragem somente de desvio, em rio com acidente natural que impede a subida de peixes. 

No diagrama são representadas somente as CGH em fase de construção ou 

operação, na forma de um triângulo diferenciado que também terá posição definida pela 

direção do rio. Logo, a classificação é a seguinte: 

a. Quando a CGH estiver entre os estágios 11 e 12, classifica-se como “CGH em 

Operação ou Construção sem reservatório” e representa-se assim: 

 

 

 

3.4.2.3  UHE 

UHE (Usina Hidrelétrica de Energia) são usinas hidrelétrica cuja capacidade 

instalada seja superior a 30MW (trinta megawatts), que possuam reservatório maior que 

3 km² (300 ha) ou assim definidas pela ANEEL.  

No diagrama, as UHE são representadas por um losango e seguem a mesma 

classificação das PCH: 

 

a. Quando a UHE estiver entre os estágios 1 e 8, considera-se “UHE em estudo 

para implantação” e representa-se assim: 

CGH Nome 
Área de drenagem ANA / SRTM30 

Altitude SRTM30 
 

PCH Nome 
Área Drenagem ANA /SRTM30 / Altitude SRTM30 

PCH Nome 
Área Drenagem ANA /SRTM30 / Altitude SRTM30 
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b. Quando a UHE estiver no estágio 9 ou 10, considera-se “UHE com outorga 

para implantação” e representa-se assim: 

 

 

c. Quando uma UHE estiver entre os estágios 11 e 12, classifica-se como “UHE 

em Operação ou Construção – Reservatório Menor ou Igual a 3 km²” e 

representa-se assim: 

 

d. Considera-se o estágio 13 (revogado) um retorno à etapa de estudo e, portanto, 

segue-se a mesma classificação do item a. 

e. Ainda há o estágio 14 que indica o estado desativado ou extinta. Este, porém é 

bastante raro e é representado assim: 

 

3.4.2.4  Quadro Resumo 

Abaixo segue quadro resumo das simbologias utilizadas para AHE. 

Estágios UHE PCH CGH* 

AHE em Operação 
ou Construção 

 Construção com outorga 

 Operação 

 Revogado 

   

AHE com Outorga 
para Implantação 

 DRS-PCH 

 Construção não iniciada 

   

AHE em Estudo 
para Implantação 

 Eixo Disponível 

 VB com Registro, com Aceite, 
ou VB Aprovado 

 PB com Registro, com Aceite, 
ou PB Aprovado 

 DRI-PCH 

   

AHE Desativada ou Extinta 
   

*Escolheu-se apresentar apenas as CGH em Operação ou Construção por se tratar de uma AHE deveras 

pequena. 

3.5 Verificação dos dados 

Com o diagrama esquematizado, e a área de drenagem das estações fluviométricas, 

UHE, PCH e CGH já geradas, parte-se para verificação dos dados. Essa é feita através da 

UHE Nome 
Área Drenagem ANA /SRTM30 / Altitude SRTM30 

UHE Nome 
Área Drenagem ANA /SRTM30 / Altitude SRTM30 

UHE Nome 
Área Drenagem ANA /SRTM30 / Altitude SRTM30 

UHE Nome 
Área Drenagem ANA /SRTM30 / Altitude SRTM30 
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comparação dos valores de altitude e área de drenagem informados nos inventários e 

aqueles obtidos com base no MDE SRTM30.  

No ArcGIS, os dados obtidos devem ser primeiramente exportados para planilhas 

de excel. Exporta-se estes shapefiles, abrindo a “Tabela de Atributos”, selecionando 

em           (Opções da Tabela) o ícone “Exportar...”. Salvar como arquivo de texto e abrí-

lo no excel.  

No QGIS, pode-se gerar a área de drenagem de cada ponto, culminando em “n” 

arquivos raster, os quais posteriormente são todos transformados em camadas, e podem 

por fim, então, ser unidas numa única camada. Por fim, pode-se clicar com o botão direito 

nessa camada-união e salvá-la, Save as, como arquivo formato excel, “MS Office Open 

XML spreadsheet [XLSX]”. 

Todos os pontos que apresentarem diferenças significativas de área de drenagem 

devem ser verificados no ArcGIS. Deve-se fazer uma análise a respeito das diferenças 

encontradas com base nas possibilidades de posicionamento dos pontos. Caso for 

encontrada, nesta etapa, um local mais adequado para a marcação do “BatchPoint”, ou, 

no QGIS, “Outlet point”, este procedimento deve ser refeito e os dados devem ser 

substituídos. Todos os “BatchPoint” que ficarem muito distantes dos pontos cadastrados 

nos inventários devem ser informados à entidade responsável pela divulgação dos dados. 

Aqueles que gerarem dúvidas sobre a sua posição também serão informados. 

Algumas dúvidas também podem e devem ser esclarecidas com o uso do Google 

Earth. Segue abaixo exemplo da diferença entre a representação no ArcGIS e no Google 

Earth da posição da estação 76500000 – Jacaqua. Na figura abaixo, verifica-se um erro 

na geração da drenagem pelo MDE SRTM30, constatado apenas pela verificação das 

imagens de satélite do Google Earth. A estação esta rio principal, em vez de estar no 

afluente sinuoso. 
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3.6 Distâncias 

Após a verificação, análise e possível modificação do posicionamento das estações 

fluviométricas, UHE, PCH e CGH, pode-se então calcular as distâncias. 

Todos os rios representados no Diagrama Unifilar devem ser isolados e a 

ferramenta “Dissolver” deve ser utilizada para que cada rio seja representado somente por 

um trecho. Esta ferramenta se encontra em “ArcToolbox” > “Ferramentas de 

Gerenciamento de Dados” > “Generalização” > “Dissolver”. 

Cada rio então será dividido nos pontos onde existir algum aspecto de interesse: 

estações fluviométricas, UHE, PCH, CGH, afluentes, etc. Esta divisão é feita por meio da 

Barra de Ferramentas “Editor” e a ferramenta “Dividir” (     ). 

– Com o rio dividido em trechos, abre-se a “Tabela de Atributos”.  

– Em “Opções de Tabela” selecionar “Adicionar Campo...”.  

– Nomear o campo “Distancia” e definir como tipo “Duplo”. 

– Antes de seguir para os próximos passos, deve-se garantir que o sistema de 

coordenadas da estrutura de dados seja o Lambert e que as coordenadas sejam 

referenciadas ao Datum SIRGAS2000. 

– Clicar com o botão direito do mouse sobre o cabeçalho da nova coluna na 

Tabela de Atributos e selecionar “Calcular Geometria...”. 

– A seguinte caixa de diálogo será aberta: 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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– Definir a propriedade “Comprimento”, selecionar o sistema de coordenadas 

da estrutura de dados e utilizar como unidade “Quilômetros [km]”. 

– Após este procedimento, na coluna “Distância” estará o comprimento de cada 

um dos trechos que foram divididos. Estes dados podem ser então 

acrescentados no Diagrama Unifilar. 

Este procedimento será repetido para cada um dos rios representados no diagrama 

unifilar. 

Para facilitar a visualização e montagem do diagrama, aconselha-se utilizar o rótulo 

da distância para agilizar a montagem. 

 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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 No QGIS, o processo é semelhante. Usando-se o vetor de drenagem derivado do 

raster de Stream segments, obtido no item 2.2.6, basta realizar processos de “Advanced 

Digitizing” (Figura abaixo). Deve-se tornar a camada editável, clicando em Toggle 

Editing . Usa-se as ferramentas de corte de feições , Split Features, união de 

feições , Merge Selected Features, seleção de feições , Select Features by area 

or single click, e deselecionar , Deselect Features from All Layers. Quando se 

pretende cortar duas vezes o mesmo segmento, é necessário cortar uma vez, salvar a 

edição, e abrir novamente o modo de edição. Para tal, basta clicar em  “Save for 

Selected Layers(s)”. 

 

Salienta-se aqui ainda que para calcular as distâncias no QGIS, deve-se utilizar a 

devida projeção de maneira descrita nos e 2.1.7, para o ArcGIS, e 2.2.7, para o QGIS. 

Depois usando “Export/Add geometry columns”, extrai-se o valor de distância da camada 

como descrito no item 3.2. 

3.7 Áreas de Drenagem 

Uma das informações de relevância que pode ser extraída de um Diagrama Unifilar 

é a definição dos pontos para os quais a precipitação medida nas estações pluviométricas 

vai drenar. Em consequência disso, também se define quais dados de vazão são 

influenciados por estes dados de precipitação. Estas informações devem ficar bastante 

claras quando se analisa um diagrama Unifilar. Por isso, em áreas onde surgirem dúvidas 

a respeito destas informações, deve-se verificar a situação no ArcGIS e esclarecer no 

diagrama.  

O exemplo abaixo mostra uma situação no ArcGIS e como ela foi representada no 

diagrama. O ponto laranja representa a estação fluviométrica 76290000 – Passo dos 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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Farrapos enquanto o ponto verde representa a estação pluviométrica 3055005 – Santa 

Rita. 

 

 

4. Consistência de dados inventariais para construção do Diagrama 

Unifilar 

Os dados inventariais de estações da ANA e/ou UHE, PCH e CGH da ANEEL 

deverão ser consistidos (verificados) para serem, com segurança, colocados no diagrama 

unifilar a ser construído. A localização geográfica das estações fluviométricas, 

pluviométricas e dos barramentos deve ser via SIG confrontada com camada de bacias 

hidrográficas, área territorial dos municípios, etc., para conferência com os dados 

registrados. Incongruências nestes dados são indicativos que podem apontar para algum 

equívoco de localização (coordenadas) do item a ser representado no diagrama unifilar. 

A delimitação automática do perímetro e o consecutivo cálculo da área de drenagem 

de estações fluviométricas, utilizando algum MDE, para posterior conferência com os 

dados disponibilizados no inventário da ANA e/ou ANEEL, fornece um bom indicativo 

que a localização geográfica (coordenadas) da estação e/ou empreendimento hidrelétrico 

pode estar errada. Para tanto, sugere-se adotar como hipótese de equívoco da coordenada 

geográfica quando uma diferença igual ou maior de 1% entre a área obtida pelo MDE e a 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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que consta nos inventários (estação F ou FD,ou CGH ou PCH ou UHE) apresentar-se. 

Deve-se então entrar em contato com a ANA e/ou ANEEL para solicitar uma verificação 

dos dados disponibilizados de tais estações no inventário. É importante enunciar no e-

mail a data do inventário em questão.  

O mesmo procedimento de verificação de área de drenagem também pode ser feito 

para altitude de estações fluviométricas ou pluviométricas. Extraindo a altitude do MDE 

para cada estação, compara-se com os dados de inventário, levando a um indicativo de 

equívoco na localização geográfica estação. Com relação à altitude, sugere-se que o 

analista adote como hipótese de equívoco nos dados fornecidos quando a diferença entre 

a altitude no inventário e a altitude segundo o raster do SRTM30 for maior que 30m de 

diferença. Semelhantemente, nesse caso, deve-se contatar a ANA. 

Uma maneira prática de realizar essa verificação da altitude, que é um indicativo de 

posicionamento geográfico equivocado da estação, é por exportar a camada referente às 

estações pluviométricas e fluviométricas para o Excel após adicionar os dados de cota do 

STRM30 já mencionados no item 2.1.4/2.2.4. Após isso, deve-se deletar as colunas 

indesejadas no excel e criar uma nova coluna para calcular o módulo da diferença de 

altitude medida em campo com a extraída pelo SRTM 30. Por fim, aplica-se uma 

formatação condicional a fim de modificar o preenchimento das células que necessitam 

ser revisadas e encaminhadas para a ANA. Um modelo desse 

arquivo de excel pode ser encontrado nesse sítio. 

Devem ser averiguadas situações em que a localização de estações fluviométricas, 

PCH, UHE ou CGH estiver muito distante de cursos d’água, ou quando houver dúvidas 

quanto à correta localização do ponto. Abaixo segue imagem em que há quatro estações 

todas com o mesmo nome, mas em locais ligeiramente diferentes. Pode ser que todas 

tenham sido instaladas no mesmo local, porém mediu-se a posição de maneira 

equivocada; cabe serem conferidas. 

 

 

  

https://drive.google.com/open?id=0B5VdVLrE05QEZExqdG1XUkotOWc
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Caso algum dos dados esteja ausente no hidro da ANA deve-se marcar a estação 

para posteriormente tirar as dúvidas. 

 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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Por fim pode-se também confrontar os dados com o arquivo shapefile (.shp) dos 

municípios do IBGE: se a cidade não for a mesma, é sinal que pode haver algum erro. 

 
 

Exemplos de erros verificados 

 

Abaixo segue um exemplo de dúvida que surgiu durante a construção de um 

diagrama unifilar. O inventário da ANA de 10 de julho de 2015 colocava a estação 

76600000 – Passo do Itaum entre dois meandros do rio Ibicuí. Foi enviado um pedido 

pelo site de Acesso a Informação e a ANA respondeu informando coordenadas mais 

precisas para a estação. As novas coordenadas colocavam a estação no ponto verde, 

representado abaixo, não deixando dúvidas quanto o meandro ao qual a estação realmente 

pertence. 

 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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Todas as estações F a jusante em um curso d’água devem possuir cota menor e área 

de drenagem maior em relação as de montante. Caso isso não esteja de acordo na 

construção do diagrama, há inconsistência. A seguir disponibiliza-se um modelo e exemplos 

de verificação dos dados de coordenadas geográficas das estações junto a ANA. O mesmo 

deve ser realizado para os barramentos (UHE, PCH e CGH) e caso haja inconsistências elas 

devem ser encaminhadas para ANEEL. Um exemplo disso é disponibilizado junto com os 

outros sítios abaixo. 

Sítio para acessar o modelo de verificação das coordenadas geográficas das estações 

pluviométricas e fluviométricas:  

https://drive.google.com/open?id=0B5VdVLrE05QEcThLdHltQTY0cXM 

Sítio para acessar a verificação das coordenadas geográficas das sub-bacias 80 a 84: 

https://drive.google.com/open?id=0B5VdVLrE05QEckxUZzEtZHZDazg (Sub-Bacia 80) 

https://drive.google.com/open?id=0B5VdVLrE05QEdlUta2cycnN5UkU (Sub-Bacia 81) 

https://drive.google.com/open?id=0B5VdVLrE05QEdmZtcFpPeEN0Smc (Sub-Bacia 82) 

https://drive.google.com/open?id=0B5VdVLrE05QEV2NFNElxY045aEE (Sub-Bacia 83) 

https://drive.google.com/open?id=0B5VdVLrE05QEOHRkRlM4NDR1YU0 (Sub-Bacia 84) 

Sítio para acessar a verificação das coordenadas geográficas dos barramentos da 

bacia 8: https://drive.google.com/open?id=0B5VdVLrE05QEb2ZFVGM5YU9hSmM 

4.1 Acesso à informação do governo federal 

Dúvidas ou erros verificados ao longo do processo de construção do Diagrama Unifilar 

devem ser informados a entidade responsável pela divulgação dos dados (no nosso caso, 

ANA ou ANEEL). Caso o dado não possa ser obtido pela entidade, deve-se tentar com a 

entidade responsável pela estação ou barramento. 

Em último caso isto pode ser feito através do portal de Acesso a Informação em 

http://www.acessoainformacao.gov.br/. Deve-se criar um login e fazer um pedido no site. 

A seguir, um modelo de "carta" para se mandar para a ANA pedindo a verificação de dados 

inventariais: 

Título: Conferência altitude / coordenadas geodésicas de estações da sub-bacia xx 

Caro(a) responsável da ANA, 

Pedimos a verificação da altitude e coordenadas geodésicas de xx estações, em anexo, 

da rede hidrometeorológica nacional, cujos dados foram disponibilizados no sistema 

hidroweb no inventário datado de x de xxx de 20xx. 

No anexo verificaram que há diferenças significativas da altitude registrada no 

inventário de 3 de julho de 2015 em relação a extração das altitudes pelo MDE de 30 m 

https://drive.google.com/open?id=0B5VdVLrE05QEcThLdHltQTY0cXM
https://drive.google.com/open?id=0B5VdVLrE05QEckxUZzEtZHZDazg
https://drive.google.com/open?id=0B5VdVLrE05QEdlUta2cycnN5UkU
https://drive.google.com/open?id=0B5VdVLrE05QEdmZtcFpPeEN0Smc
https://drive.google.com/open?id=0B5VdVLrE05QEV2NFNElxY045aEE
https://drive.google.com/open?id=0B5VdVLrE05QEOHRkRlM4NDR1YU0
https://drive.google.com/open?id=0B5VdVLrE05QEb2ZFVGM5YU9hSmM
http://www.acessoainformacao.gov.br/
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(disponível em:http://earthexplorer.usgs.gov/). Este fato nos alerta para um possível 

equívoco de localização geográfica destas estações. 

Estamos construindo um diagrama unifilar das sub-bacias da bacia x visando estudos 

hidrológicos e a correta localização geográfica dos dados é essencial para não produzirmos 

informações erradas. 

Cordialmente, 

Se nenhuma dessas medidas surtir efeito, os dados devem ser deixados em branco no 

diagrama, mas lembre-se que para uma maior confiabilidade, deixar o dado em branco é a 

última opção. O ideal é ter o máximo de dados possíveis no diagrama com certeza dos 

valores.  

4.2 Outra abordagem para se consistir os dados 

Há também outra maneira para se consistirem os dados inventarias. Nela não se usa 

o Hidro, apenas o próprio programa de SIG. Porém, para usá-la, faz-se necessário preparar 

a tabela Excel. No item 2.1.2/2.2.2 constam os passos para se adicionar uma coluna nova 

de município aos dados inventarias. A função dessa coluna é tão somente interpretar os 

códigos da ANA, e retornar em texto (string) o nome do município. Na consistência de 

dados se costuma consistir os tais cinco itens: 

– Altitude 

– Área de Drenagem 

– Código 

– Município 

– Nome do Rio 

Sendo assim, pode-se criar também uma coluna para nome do rio no excel das 

estações, e em processo semelhante ao item 2.1.2/2.2.2, importar a relação de “nome do 

rio”-“código ANA de nome do rio”. Depois, importa-se essa tabela excel para o programa 

de SIG, e extrai-se do MDE (SRTM30) a altitude de cada ponto, e, por fim, adiciona-se 

o cálculo de área de drenagem para cada estação. Assim, torna-se capaz trabalhar apenas 

com o programa de SIG para fazer a consistência de dados. Costuma-se então manipular 

os rótulos que aparecerão no programa de SIG. Pode-se definir um rótulo que apresente: 

código da estação, altitude_ANA, área de drenagem_ANA, altitude_SRTM, área de 

drenagem_SRTM, município_ANA e nome do rio_ANA. Adiciona-se também o rótulo 

para a camada de municípios e drenagem. Embora essa abordagem seja mais trabalhosa 

no início, ela facilita bastante para visualizar os dados.  

http://earthexplorer.usgs.gov/
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Como exemplo, apresenta-se em seguida uma consistência de municípios. A 

primeira parte que consiste em criar coluna de município onde o nome esteja em texto 

(string) consta no item 1.1.g. 

Para checagem de municípios se compara o campo MunicípioNome (criado no item 

2.1.2/2.2.2) do shapefile criado a partir do inventário ANA com a camada de municípios 

mais atual que pode ser obtida pelo site do IBGE (<http://mapas.ibge.gov.br/bases-e-

referenciais/bases-cartograficas/malhas-digitais.html>). 

Uma abordagem é adicionar à legenda da camada de estações o campo 

“MunicípioNome”, e adicionar à legenda da camada de municípios do IBGE o campo 

“Nome”. Clica-se em propriedades da camada de estações, 

 

 

Clica-se em “Label”, ou rótulo, seleciona-se “Label features in this layer”, clica-

se em “Expression...”, digita-se “[Codigo] & vbnewline & [MunicípioN]”, clica-se ok 

e ok. 

 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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Para a camada de municípios do IBGE, segue-se processo semelhante, porém 

digita-se “[NM_MUNICIP]”. Sugere-se que em “Text Symbol”, utilize-se uma fonte 

diferente daquela da utilizada para as estações. 

Por fim, pode-se checar uma por uma conforme o diagrama unifilar é produzido. 

Abaixo segue imagem de exemplo. Optou-se por um tamanho maior e em negrito para os 

rótulos dos municípios, possibilitando a melhor visualização do Usuário. 

 

Deve-se notar que algumas estações estão em divisa de municípios, e não se deve 

considerar errôneo caso o nome apontado pelo inventário ANA seja do município 

ligeiramente vizinho. Deve-se atentar não por menos quando os municípios não 

possuírem divisa. 

Processo semelhante também é sugerido para consistir dados de localização do 

inventário da ANEEL (AHE: UHE, PCH, CGH). Nesses a expressão utilizada é 

“[NOME] & vbnewline & [MUNIC_1] & vbnewline & [MUNIC_2]”. O inventário 

ANEEL apresenta dois campos de municípios porque os AHE costumam se encontrar na 

divisa de municípios. 

Exemplo 

A seguir mostra-se um exemplo de diagrama Unifilar feito com base nesta 

metodologia. A divisão das sub-bacias apresentada foi baseada na metodologia 

desenvolvida por Otto Pfafstetter. O diagrama unifilar apresentado a seguir pode ser 

observado em detalhes no trabalho de Koefender (2015). 

http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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5. Modelo padrão e demais materiais para construção do diagrama 

unifilar proposto neste tutorial 

No Quadro 1, mostram-se os endereços (“sítios”) para baixar o modelo padrão 

inicial para construção do diagrama unifilar segundo a metodologia e a semiologia 

cartográfica (legenda) propostas neste tutorial. Este material também pode ser solicitado 

pelos emails dos autores (amalia.koe@gmail.com; francisco.marcuzzo@sgb.gov.br; gmg

uimaraess@gmail.com; juliano.finck@gmail.com). 

 

Quadro 1 – Material para baixar da internet para construção de diagrama unifilar. 

Material 

Endereços (“sítios”) Para Baixar o Material Visando a 

Construção de Diagrama Unifilar de Bacia Hidrográfica Para 

Estudos Hidrológicos 

Modelo Padrão Inicial (.docx) Para 

Construção de Diagrama Unifilar 

https://onedrive.live.com/view.aspx?cid=f3e4c2a1ea29981a&page=view&resid=F3E4

C2A1EA29981A!238&parId=F3E4C2A1EA29981A!220&app=Word&wacqt=undefi

ned 

Tutorial: CONCEPÇÃO DE DIAGRAMA 

UNIFILAR DE BACIA HIDROGRÁFICA 

PARA ESTUDOS DE INTERESSE 

HIDROLÓGICO: O passo a passo de como 

obter as informações, como montar o 

diagrama unifilar e como verificar e corrigir 

seus dados inventariais básicos 

https://onedrive.live.com/view.aspx?cid=f3e4c2a1ea29981a&page=view&resid=F3E4

C2A1EA29981A!236&parId=F3E4C2A1EA29981A!220&app=WordPdf&wacqt=und

efined 

Tutorial: Como Baixar Imagens SRTM30 

(2014), Mosaicar, Calcular Área de 

Drenagem, Extrair Altitude, Gerar MDE e 

Criar Mapa de Declividade Versão 2 

https://onedrive.live.com/view.aspx?cid=F3E4C2A1EA29981A&resid=f3e4c2a1ea29

981a%21222&app=WordPdf&wdo=1 

Ottocodificação de Bacias Hidrográficas 
https://drive.google.com/file/d/0B6T7sNg_aVgObEhkLWdDZVlXaGM/view?usp=sha

ring 

 

  

file:///E:/C/RegQ/SIG_Projetos_Shapes_Tutoriais/Tutoriais_e_Informações/amalia.koe@gmail.com
mailto:francisco.marcuzzo@cprm.gov.br
mailto:gmguimaraess@gmail.com
mailto:gmguimaraess@gmail.com
https://onedrive.live.com/view.aspx?cid=f3e4c2a1ea29981a&page=view&resid=F3E4C2A1EA29981A!238&parId=F3E4C2A1EA29981A!220&app=Word&wacqt=undefined
https://onedrive.live.com/view.aspx?cid=f3e4c2a1ea29981a&page=view&resid=F3E4C2A1EA29981A!238&parId=F3E4C2A1EA29981A!220&app=Word&wacqt=undefined
https://onedrive.live.com/view.aspx?cid=f3e4c2a1ea29981a&page=view&resid=F3E4C2A1EA29981A!238&parId=F3E4C2A1EA29981A!220&app=Word&wacqt=undefined
https://onedrive.live.com/view.aspx?cid=f3e4c2a1ea29981a&page=view&resid=F3E4C2A1EA29981A!236&parId=F3E4C2A1EA29981A!220&app=WordPdf&wacqt=undefined
https://onedrive.live.com/view.aspx?cid=f3e4c2a1ea29981a&page=view&resid=F3E4C2A1EA29981A!236&parId=F3E4C2A1EA29981A!220&app=WordPdf&wacqt=undefined
https://onedrive.live.com/view.aspx?cid=f3e4c2a1ea29981a&page=view&resid=F3E4C2A1EA29981A!236&parId=F3E4C2A1EA29981A!220&app=WordPdf&wacqt=undefined
https://onedrive.live.com/view.aspx?cid=F3E4C2A1EA29981A&resid=f3e4c2a1ea29981a%21222&app=WordPdf&wdo=1
https://onedrive.live.com/view.aspx?cid=F3E4C2A1EA29981A&resid=f3e4c2a1ea29981a%21222&app=WordPdf&wdo=1
https://drive.google.com/file/d/0B6T7sNg_aVgObEhkLWdDZVlXaGM/view?usp=sharing
https://drive.google.com/file/d/0B6T7sNg_aVgObEhkLWdDZVlXaGM/view?usp=sharing
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6. Como referenciar, em referências bibliográficas, este tutorial visando 

citar a utilização do modelo e dos procedimentos aqui exemplificados 

KOEFENDER, A.; SOUZA, C. J. R.; ALMEIDA, D. B; GUIMARÃES, G. M.; FINCK, 

J. S.; MARCUZZO, F. F. N. A CONCEPÇÃO DE DIAGRAMA UNIFILAR DE 

BACIA HIDROGRÁFICA PARA ESTUDOS DE INTERESSE HIDROLÓGICO: 

O passo a passo de como obter as informações, como montar o diagrama unifilar e 

como verificar e corrigir seus dados inventariais básicos. 2025. 90p. versão 4.2. 

Tutorial. Manual desenvolvido durante estágio no projeto de regionalização de vazões na 

SGB-PA/GEHITE. Porto Alegre, 2025. Disponível em: https://rigeo.sgb.gov.br/. Acesso 

em: 21 Mai. 2025. 

  

http://lattes.cnpq.br/1759463038460288
http://lattes.cnpq.br/1923800998058989
https://rigeo.sgb.gov.br/
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